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SA-DMA Integration

This chapter discusses the use of HP Database and Middleware Automation (DMA) flows with
HP Server Automation's Application Deployment Manager.

To follow the procedures in this chapter, you must be familiar with DMA flows, the DMA
interface, and the Application Deployment Manager interface.

The chapter includes the following topics:

¢ Prerequisites to Run DMA Flows on page 9
e Connecting to DMA on page 9

e Installing DMA Agents on page 10

e Testing Your DMA Configuration on page 15

For more information on DMA flows or the Application Deployment Manager, see the
Database and Middleware Automation User Guide and the Application Deployment Manager
User Guide.

Prerequisites to Run DMA Flows

This section describes the major steps required to run DMA flows.

e Install and configure a DMA server. Steps for this process are documented in the DMA
Installation Guide.

e Configure Application Deployment Manager to communicate with DMA — see Connecting
to DMA on page 9 and the Application Settings section in the Application Deployment
Manager User Guide.

e Install DMA agents on the managed servers where the DMA flows will be run — see the
DMA Installation Guide.

e C(Create an application that includes your DMA workflow or deployment — see Creating
DMA Flow Components in the 9.02 Application Deployment Manager User Guide.

e Deploy your application using Application Deployment Manager — see the Application
Deployment Manager User Guide.

Connecting to DMA

To create a connection between DMA and Application Deployment Manager:

1 As an Application Deployment Manager administrator, open Application Deployment
Manager from within SA (choose Tools » Application Deployment).

2 In Application Deployment Manager, select the Administration tab.
3 Choose Application Settings.
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Figure 1l Application Settings Section
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4  In the Application Settings section, enter the following information:
— URL: URL of the server where DMA is installed.
— User name: User name that has DMA administrative privileges.
— Password: Password corresponding to the user name.

5 Click Verify Connection to test your Application Deployment Manager/DMA
connection.

A connection status message is displayed.

Installing DMA Agents

There are three major steps involved in installing DMA agents:

¢ Identify the managed-server candidates where you should install the agents — see

Identifying Managed Server Candidates on page 11.

e Confirm that the DMA agent can be installed on your system and follow the correct steps

to install the agent — see Installing DMA Agents On Your System on page 11.
e Activate the DMA agent — see Activating the DMA Agent on page 13.
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|dentifying Managed Server Candidates

You can use Application Deployment Manager targets to help you decide on which managed
servers you should install the DMA agents.

If you deploy an application that runs DMA flows to a target, all managed servers that the
target references must have a DMA agent installed. For example, as the following figure
shows, if you were to deploy an application to the target 0aA: Test, which references the
managed server myserver.hp.com, you must install the DMA agent on the myserver.hp.com
server.

Figure 2 Target Server

iy | QA:Test| ~ llJlEJ
% B X

Note: At deployment time, if a referenced managed server does not have a DMA agent
installed, Application Deployment Manager will issue the following warning:

Deployment Errors

Please correct the Following errors;
Server myserver.hp.com dogs not have a DRAS agent installed,

(1] 4

Installing DMA Agents On Your System

DMA agents are supported on the following platforms:
Table 1  Platforms that Support the DMA Agent

Platform Version

AIX 5.1 pSeries
5.3 pSeries
6.1 pSeries

HP-UX 11.23 pa-risc

11.23 Itanium?2
11.31 pa-risc
11.31 Itanium?2

Linux - RedHat EL 4 1386, x86 64

SA-DMA Integration 17
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Table 1 Platforms that Support the DMA Agent (cont’d)

Platform Version
Linux - RedHat EL 5 1386

x86 64
Solaris 9 Sparc
Solaris 10 Sparc

x86
Windows 2003 Server x86

x86 64
Windows 2008 Server xX86

x86 64

See the DMA Installation Guide for details on installing agents on individual platforms.
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Activating the DMA Agent

This section explains how to activate the DMA agent.
Note: For information about bulk agent activation, contact your HP support representative.

After you install DMA agents on the managed servers you chose in Identifying Managed
Server Candidates on page 11, you must activate the agents using the DMA interface.

To activate the agent:
1 Log in to the DMA Nerve Center.
Figure 3 DMA Dashboard

) Database & Middleware Automation

Automation  Provisioning  Monitors ~ Alertis  Repo Environment 3 Solutions  Setup

Dashboard

Automation Coverage
(% Servers Automated)

HP-5W03-Fahrenheit t...

Apply Oracle Patchse...

HP-5W06&-Passing Para.

HP-SWO01-Ping Server

2 In the navigation bar, click Environment.

Figure 4 Environment Tab

) Database & Middleware Automation User: administrator  Logout

Automation P Monitors  Alerts  Reports  Environment  Solutions  Setup

Dashboard Smart Groups Discovery Agents Modules Routines Custom Fields

Environment @
# Default H bluepaddie_cndhp.com -

H elysian cnd hp.com !

B fattire 3

B fivebarrel.cnd_hp.com
B frambozen.cnd.hp.com
B hanjabi cnd hp.com

B isolation T

NEW ORGANIZATION  DISCOVERY

Double click an object to open its editor here.

3 To the right of the Environment window, click New Organization to create the new ADM
organization.

SA-DMA Integration 13
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Figure 5 Create New Organization

New organization
Properties Custom Fields Policies Roles

General

Name: ADM

4  In the New organization window, enter ADM in the Name field and click Save.

If the information was saved correctly, an Organization Saved Correctly message and the
ADM environment icon are displayed.

Figure 6 ADM Environment Icon

) Database & Middleware Automatien User: administrator Logout

Automation  Provisioning  Monitors  Alerts  Reports  Environment  Solutions  Setup
Dashboard Smart Groups Discovery Agents Modules Routines Custom Fields

Environment @
& Default
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5 To the left of the Environment window, click Discovery.

Figure 7 Discovery Window

) Database & Middleware Automation

Automation  Provisioning  Monitors  Alerts  Reports  Environment  Solutions  Setup

Dashboard Smart Groups Discovery  Agents  Modules Routines  Custom Fields
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m

A hanjabi cnd hp.com
H isolation
H kidd.cnd hp.com
H kriek.cnd hp.com
H mothership cnd hp.com
g spin
=]
6 In the Discovery window:
a Choose ADM from the organization menu.

b Select a server from the new servers list.

¢ Click the green plus icon “ to add servers to the ADM organization.
7 Click Save.

Repeat the steps in this procedure for each managed server that requires a DMA agent.
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Troubleshooting the DMA Agent Installation

Linux Installation

You might need to install additional RPM dependencies.

Note: If you are upgrading from a previous release of Stratavia Data Palette to DMA 1.0, you
will need to delete your existing solution packs and re-install the equivalent HP DMA
Solution Packs.

Testing Your DMA Configuration

After you complete the configuration described in this chapter, you will be able to use DMA
flows in Application Deployment Manager. To verify that your DMA integration is working
correctly, create an application that uses a DMA flow and deploy it using Application

Deployment Manager. For more information, see the Application Deployment Manager User
Guide.

SA-DMA Integration 15
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2  SA-NA Integration

SA-NA Integration Overview

Implementing changes in an IT environment often requires a coordinated effort between
network administrators, system administrators, and application architects who must manage
an application environment that may consist of servers with different operating systems as
well as network devices that can include firewalls, load balancers, switches, servers, Web
applications, and so on.

For example, in some environments, you are required to make changes to network devices in
front of an application, such as load balancers, firewalls, switches, and so on.

SA-NA Integration makes this process easier by enabling you to see how servers are
connected to network devices and enables them to closely examine managed servers. With
this information, you can determine how all devices are related and coordinate and
implement required changes.

Figure 8 shows some of the coordinated tasks you can perform through SA-NA Integration.

Figure 8 Overview of Coordinating Tasks Using SA-NA Integration

Firewall conduits added to allow

Firewalls O application trafic to new server

Load & Load balancer configuration is
Balancers updated for new server
. — Switch configuration is updated
Switches - = - @ based on new server
EEE;EETS = @ Add new server
Application Application @ = Application
Servers servers are _ Servers
re-configured =
to acoept
Database connecton H £ £ Database
Servers from new . E E Servers
SEMVET = = =

@ Senver added to monitoring, backup, and othermanagement utilities

This section contains information about how to configure NA Integration with SA. After
integration is established, you can view device details, examine connections between network
devices and servers, identify duplex mismatches, and view combined device history
information. It also contains information about implementing changes across the
environment and generating network reports.
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To support an integrated approach to making changes in your environment, such as server
reallocation, ensuring compliance across servers and network devices, and detecting and
resolving duplex mismatches, SA-NA Integration provides the following interface points:

e HP Server Automation (SA)

e Network Automation (NA)

e SA Global Shell

e Service Automation Visualizer (SAV) (in SA)
e HP Reports (in SA)

SA-NA Infegration Features

After SA-NA Integration is configured you can perform the following tasks:

e View summarized and detailed hardware information about SA Managed Servers and
their attached network devices, and about their network connections (interfaces and
ports).

e Use the SA Global File System (OGFS) to:

— navigate between managed servers and connected network devices by tracing their
associated physical connections

— find network device configurations
— run scripts across servers and network devices.

e Call NA scripts from SA scripts to automate operations across servers and network
devices.

e Use features in SA and NA to create diagrams that illustrate the managed servers,
network devices, and layer 2 (and inferred layer 1) connections in your environment.

e Use SA to identify, troubleshoot, and remediate configuration duplex mismatches between
managed servers and network devices.

e Use SA to perform actions on SA Device Groups that can contain both servers and
network devices.

e Use SA to review a combined server and network device event history log that records
changes made to applications in your environment.

e Use SA to export combined event history logs to CSV and/or HTML files.
e Use NA to directly access additional network device details and event history.
e Use SA to run network reports that identify layer 2 and inferred layer 1 connections and

configuration mismatches (duplex compliance).

) References to connections in this document refer to physical connections, except where noted.
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How NA Data is Collected

The SA-NA Integration feature uses the NA Topology Data Gathering and NA Duplex Data
Gathering diagnostic tools to collect information about network devices.

NA Topology Data Gathering Diagnostic

The NA Topology Data Gathering diagnostic instructs NA to collect MAC addresses for all
switches. MAC addresses are required to discover and add physical connections to the SA data
model.

For example, when you add a server to a switch, that information is collected the next time
the NA Topology Data Gathering diagnostic runs. You can also manually run the NA Topology
Data Gathering diagnostic or the NA Duplex Data Gathering diagnostic for specific network
devices. For more information about these diagnostics, see the NA User Guide.

) For NA performance reasons, you should not run these diagnostics on multiple devices more
frequently than once a week. If you are required to refresh the NA data more frequently,
contact your support representative. These diagnostics can be run on single devices more
frequently.

NA Duplex Data Gathering Diagnostic
For network devices, speed and duplex is gathered by the NA Duplex Data Gathering

diagnostic, which runs after a device is initially added to NA and subsequently according to a
schedule that you define.

To ensure that you have the latest speed and duplex information about network devices, SA
recommends that you set up a recurring schedule that runs the diagnostic. For more
information about this diagnostic and scheduling, see Duplex Mismatch on page 31 and the
NA User Guide.

NA Database/SA Database

The NA and SA databases are not integrated — NA and SA each manage their own data.

Authentication

For SA/NA integrated functionality, authentication is handled by SA. For more information,
see NA Authentication Configuration on page 23. NA-only functionality continues to be
authenticated using NA credentials.

Prerequisites

The following prerequisites must be satisfied.

SA-NA Integration 19



Time Requirements

The SA and NA core servers must be synchronized and have the same time and time zone
settings.

NA Integration Port Requirements

Before you configure NA Integration, ensure that SA and NA can communicate with each
other over the following ports:

e Port 1032 (NA to SA)

NA must be able to access port 1032 on the server that is running the SA Web Services
Data Access Engine component (part of the Component Slice bundle). By default, the Web
Services Data Access Engine listens on port 1032.

e  Port 8022 (Unix) / Port 22 (Windows) (SA to NA)

For the Global File System (OGFS) feature to be able to display data about network
devices, SA must have access to port 8022 (Unix-based NA Servers) or 22 (Windows-based
NA Servers).

e RMI Ports for NA API

The NA API uses Java RMI to connect to the NA server. SA uses the NA API for the NA
integration. RMI requires that the following ports be open:

— Port 1099
JNDI

— Port 4444 (for NA versions 9.10 and earlier)
RMI Object

— Port 4446 (for NA versions 9.20 and later)
RMI Object

— Port 1098
RMI Method

SA-NA Integration Configuration Tasks

The SA administrators must perform certain tasks on SA Core servers to enable SA-NA
Integration.

Configuration includes changing certain configuration settings in both NA and SA, running
diagnostics for NA topology data, and configuring certain user permissions.

SA Client Communication with NA

Ensure that the SA Client can communicate with NA. If the SA Client cannot communicate
with the NA server, see Resetting the NA Host in the SA Client on page 26.
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Edit the jboss_wrapper.conf File

SA-NA Integration

Required only for NA versions prior to 7.6. Version 7.6 and later do not include these entries
in jboss wrapper.conf.

You should adjust the values for wrapper.java.additional.x where x > 8 is consecutive.
For example:
Change this:

wrapper.java.additional.l=-DTCMgmtEngine=1
wrapper.java.additional.2=-Duser.dir=/opt/NA750/server/ext/Jjboss/bin
wrapper.java.additional.3=-Xmnl70m
wrapper.java.additional.4=-Djava.awt.headless=true
wrapper.java.additional.5=-Dfile.encoding=UTF8

#Following are added for bug 150387
wrapper.java.additional.6=-Dorg.omg.CORBA.ORBClass=com.sun.corba.se.internal.
Interceptors.PIORB
wrapper.java.additional.7=-Dorg.omg.CORBA.ORBSingletonClass=com.sun.corba.se.
internal.corba.ORBSingleton
wrapper.java.additional.8=-Xbootclasspath/p:/opt/NA750/server/ext/wrapper/
1ib/CORBA 1.4.2 13.jar

#Add location of keystore. This is used to make SSL request.
wrapper.java.additional.9=-Djavax.net.ssl.trustStore=/opt/NA750/server/ext/
jboss/server/default/conf/truecontrol.keystore

# Bug 171948 - Need more PermGen
wrapper.java.additional.l0=-XX:MaxPermSize=80m

To this:

wrapper.java.additional.l=-DTCMgmtEngine=1
wrapper.java.additional.2=-Duser.dir=/opt/NA750/server/ext/Jjboss/bin
wrapper.java.additional.3=-Xmnl70m
wrapper.java.additional.4=-Djava.awt.headless=true
wrapper.java.additional.5=-Dfile.encoding=UTF8

#Following are added for bug 150387
#wrapper.java.additional.6=-Dorg.omg.CORBA.ORBClass=com.sun.corba.se.internal
.Interceptors.PIORB
#wrapper.java.additional.7=-Dorg.omg.CORBA.ORBSingletonClass=com.sun.corba.se
.internal.corba.ORBSingleton
#wrapper.java.additional.8=-Xbootclasspath/p:/opt/NA750/server/ext/wrapper/
1ib/CORBA 1.4.2 13.jar

#Add location of keystore. This is used to make SSL request.
wrapper.java.additional.6=-Djavax.net.ssl.trustStore=/opt/NA750/server/ext/

jboss/server/default/conf/truecontrol.keystore

# Bug 171948 - Need more PermGen
wrapper.java.additional.7=-XX:MaxPermSize=80m

2]



22

SA Configuration Changes

Complete the following tasks to prepare SA for NA Integration:

Specify the NA Server Name

If you did not specify an NA server name during the SA Core Installer Interview, you must
specify the value for the twist.nasdata.host=<hostname> parameter in the
/etc/opt/opsware/twist/twist.conf file.

Find the entry:

twist.nasdata.host=

add the hostname or IP address of your NA server.

For more information about modifying this file, see the SA Administration Guide.

If you have installed multiple Slice Component bundles, you must edit the twist.conf file on
all slices. Then, you must restart all NA services and the Web Service Data Access Engine for
each Slice component bundle.

Specify the NA Port (Windows-only) in SA

If NA is running on a Windows server, you must change the port setting parameter from
nas.port=8022 to nas.port=22 in the /etc/opt/opsware/hub/hub.conf file.

A default Windows server installation runs the proxy SSH/Telnet servers on port 22/23
rather than the Unix default of port 8022/8023.

After you make this configuration change, you must restart the server hosting the Slice
Component bundle.

Enable the spin.cronbot.check_duplex.enabled Parameter

The spin.cronbot.check duplex.enabled system configuration parameter must be
enabled for NA integration.

To enable this system configuration parameter, perform the following steps:
a Select the Administration tab in the SA Client.

b  Select System Configuration in the navigation pane. This displays the SA
components, facilities and realms that have system configuration parameters.

¢ In the list of SA components, select Data Access Engine. This displays the system
configuration parameters for this component.

d Locate the parameter spin.cronbot.check duplex.enabled.

e In the Value column, select the new value button El and set the value to 1.

f  Select the Revert button to discard your changes or the Save button to save your
changes.

For more information about system configurations, see the SA Administration Guide.
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Configuring NA for Integration

>»

SA

To configure NA Integration with the current SA version, you must have a compatible version
of Network Automation (NA) installed. For more information, see the NA Support Matrix.

The NA administrator should perform the following tasks on your NA server.

Gateway Requirements

NA must be configured to use the Master Gateway for the SA Core you are integrating with.
For more information about specifying the SA Core Master Gateway in NA, see the
NA Satellite Guide.

User Permissions

>»

Access permissions for SA-NA Integration are based on two separate databases: a NA
database and a SA database. NA uses its own database for authorization. SA uses a different

security mechanism for authorization. However, for NA integration, all authentication (for
both NA and SA) is processed by SA.

When NA is configured to use SA authentication, NA tries to authenticate against SA first. If
NA fails to authenticate against SA, it falls back to the NA database. If there is an account in
the NA database, the fallback is only allowed if that user is configured to allow fallback
authentication. See the NA User Guide for more information on NA authentication.

When a new user is authenticated through SA, an account is created in NA. The account is
placed in the Default User Group that was specified when SA authentication was enabled in
the Administrative Settings in NA. This user group, which is configurable, controls the
default permissions that the system administrator has assigned to SA users.

You must have the required set of permissions to view servers and network devices. To obtain
these permissions, contact your SA administrator, or for more information, see the SA
Administration Guide.

NA Authentication Configuration

SA-NA Integration

To set up SA-NA Integration, you must configure NA to use SA Authentication. Before
beginning this configuration, you must have this information (see Figure 10):

e Twist Server: the IP address or Hostname of the server hosting the Web Services Data
Access Engine (twist: part of the Slice Component bundle which is typically installed on
the SA Core host but can be installed on a different host).

¢ Twist Port Number: The port number that the Web Services Data Access Engine listens
on.

e Twist Username: The Web Services Data Access Engine user name.
¢ Twist Password: The Web Services Data Access Engine user’s password.

e OCC Server: The IP address or hostname of the server hosting the Command Center

(OCO).

¢ Default User Group: The default user group for new SA users.
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To change the authentication settings in NA, perform the following tasks:
1  Login to NA.

2 Select Admin » Administrative Settings » User Authentication to display the

Administrative Settings — User Authentication page.

3 In the External Authentication Type section, use the radio button to select HP Server

Automation software & TACACS+ (if used) as shown in Figure 9.
Figure 9 External Authentication Type in NA

Configuration Mgmt  Device Access  Server Workflow  User Interface  Telnet/SSH Reportmg =TS0l Server Monitoring | 3rd Party Integrations

Save

Minimum User Password Length
[ tin characters)

User Password Must Contain Upper and Lower Case
[7] Requires users to choose passwords which contain both lawer-case and upper-case alphabatic charactars.

Additional User Password Restriction . .
@ No additicnal restrictions

© Must contain at least one non-alphabetic digit or special character

) Must contain both at least one digit and at least one spedial character

Maximum number of censecutive user authentication failures, after which the user will be disabled. A value of O (zero) indicates that this

Maximum Consecutive Login Failures
Dchg(kshnu\d be skipped. Notz that this setting applies only to built-in user authentication and not to extzrnal authentication methods.

External Authentication Type
None (Local Auth)

HP Server Automation Software
HP Server Automation Software & TACACSD

Choose the typs of external authentication you would like to use.

TACACS+ Ifyou chaose TACACS+, RADIUS or HP Server Automation
Software, it can be configured in the section below,
RADIUS SecurlD has no additional external authentication options.
© LpapP

(After saving the settings, go to LDAP Setup page for more options)

4 Scroll down and complete all fields in the HP Server Automation software Authentication

section shown in Figure 10.

NA uses the Web Services Data Access Engine (twist) Username and Password when it
gathers layer 2 data. NA gathers server interface information by MAC address using the
Twist user’s permissions. The Twist user must have read access to server information.

Figure 10 HP Server Automation Software Authentication

Twist Server
ist.c43 dev.example.com Web Services Datz Access Engine host name or IP zddress
Twist Port Number
[1032 " |Web Services Dsts Accass Engins listening port [typically 1032)

Twist Username

I

efuser Web Services Datz Access Engine Usernzame for finding connected servers.

Twist Password

Resssssss Jweb Services Data Accass Engine Passward for finding connacted sarvers,
OCC Server
iocc.c43.dev.example.ocm| HP Command Center host name for linking to connected servers.

Default User Group

Limited Access User = User Group for new HP Server Automation Software users,

5 Click Save to save your configuration changes.

See the NA User Guide for more information on NA configuration.
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Configuring SA-NA Integration with CiscoWorks NCM

SA-NA Integration

If you are deploying SA with CiscoWorks NCM 1.2, you must make certain configuration
changes. Some CiscoWorks NCM deployments (where CiscoWorks LMS is co-resident with
NCM) use non-standard ports that affect integration with SA.

To determine which changes you will need to make, perform the following tasks:

Phase 1: Edit tomcat4-service.xml:

1
2

Log in to your NCM server.
Open the XML file:

<NCM_install_dir>/server/ext/jboss/server/default/deploy/
tomcatd-service.xml.

Search for the string 'scheme=https"'.
Check the preceding entry which should be
port = "port no".

If the port no value is 443, then go to Phase 4; otherwise, note the specified port and
continue to Phase 2.

Phase 2: Assign the port number:

1

2
3
4

Log in to the SA Client.
In the SA Client, from the Tools menu, select Options.
In the Set Options window, select Network Automation.

In the Host field, append :<port> to the hostname, where <port> is the port number
found in Phasel, step 4, for example:

mycore.opsware.com: 443

Click Save.

The following warning will appear: “General. Host: must be a valid host string.” Ignore
this warning. Close the Set Options window.

(Phase 2 must be performed for every user of the SA Client.)

Phase 3: Edit Primary Data Access Engine files:

1

Log in to the SA Core Server where the Primary Data Access Engine is installed (part of
the Infrastructure Component bundle).

Open the /opt/opsware/twist/twist.sh file and change this line:
https://$NASHOST/tcdocs/truecontrol-client.jar

to read (assuming that 443 was the port you noted in Phase 1, step 4):
https://${NASHOST}:443/tcdocs/truecontrol-client.jar

Restart the server hosting the Web Services Data Access Engine (part of the Component
Slice bundle):

/etc/init.d/opsware-sas restart twist

(You will need to perform Phase 3 for each Web Services Data Access Engine server
installation.)
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Phase 4: Assign the SSH port:
1  Login to NCM.

2 Select Admin » Administrative Settings » Telnet/SSH to display the
Administrative Settings - Telnet/SSH page.

3 In the SSH Server section, locate the SSH Server Port.

4  Ifthe port is 8022, then you are finished; otherwise, note the port being used and continue
to Phase 4, step 5.

5 Login to the SA Core Server where the Global File System (OGFS) is installed (part of the
Slice Component bundle).

6 Open the /etc/opt/opsware/hub/hub.conf file and change the value for nas.port to
the port you found in Phase 4, step 4. For example:

nas.port=9022

Gather Topology Data

After SA-NA Integration tasks are completed, you must run the NA Topology Data Gathering
and NA Duplex Data Gathering diagnostics. For instructions about running these utilities,
see the NA User Guide.

Troubleshooting Tips

To test whether SA is communicating with NA, check the following conditions:

®  You can log in to NA with your SA credentials. This verifies that NA can communicate
with SA.

e The SA credentials specified in the NA Administrative Settings under External
Authentication Type are set to SA. This ensures that NA can look up server MAC
addresses.

e The NA Topology Gathering Diagnostic has run successfully. To verify this condition,
search for tasks and check their results. This ensures that NA has gathered MAC
addresses and tried to look them up in SA.

Resetting the NA Host in the SA Client

Some SA-NA Integration features require that the SA Client (Java) opens the NA Web
interface (directly from SA) so that you can access additional details about certain NA events.
If your administrator has completed the setup tasks in the SA Planning and Installation
Guide, but the SA Client is unable to communicate directly with the server running the NA
host (server) Web interface, you might need to change the NA option in the SA Client. For
example, if a firewall is preventing the SA Client from reaching the NA host, you need to
specify the name of a server that is acting as a proxy for the NA host. This will override the
default setting. This task must be performed on every desktop running a SA Client that
cannot communicate with the NA host.
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To reset the NA host in the SA Client, perform the following steps:
1 From the Tools menu in the SA Client window, select Options.
2 In the Views pane, select HP Network Automation.

3 Inthe Host field, enter the name of a server that is acting as a proxy for the NA host, such
as m208, which is the proxy for the m208.example.com NA host.

4 (Optional) Click Restore Default to restore the previously saved NA host name.
5 (Optional) Click Test to open the NA login window.
6 Click Save.

Using SA-NA Integration

After you have successfully configured SA-NA Integration, the following capabilities are
available.

Connections Between Network Devices and Servers

The SA-NA Integration features are based on layer 2 connections and inferred layer 1
connections. See Figure 11 for definitions of the OSI Model layers.

Figure 11 OSI Seven Layer Model

7 Application
6 Presentation
5 Session

4 Transport

3 Network

2 Data Link

1 Physical

Data Link Connections

The SA-NA Integration feature includes functionality that detects data link (layer 2)
connections and reports on physical (layer 1) and data link connections. These data link
connections include switches that are directly connected to a managed server and switches
that are indirectly connected through other switches. These connections are discovered by
correlating the MAC addresses reported by the device with the known MAC addresses for
servers and switches.
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Physical Connections

The physical connections are inferred from the data link connections. See Inferred Physical
Connections on page 35. Physical connections represent direct connections (cables) between
server and switches.

In the SA Client, you can see physical connections in the Server Explorer, the Network Device
Explorer and in detailed layout diagrams in Service Automation Visualizer (SAV). In the NA
diagramming feature, you can see physical, data link or network (layer 3) connections.

Network Device Information in SA

In addition to basic hardware details about managed servers and network devices, the SA-NA
Integration feature also reports the following information about network interfaces and
network ports:

e On the server side, network interfaces have the following properties:
— MAC address
— subnet mask
— interface type
— IP address
— DHCP setting
— connected switch port
— speed
— duplex (excluding Windows).
¢  On the network device side, network ports have the following properties:
— port name
— speed
— duplex settings
— devices connected

— interface type.

) For most devices, auto-negotiation works best when both sides of the connection (server and
network device) are set to auto-negotiate mode. For example, a duplex policy could specify
that a port should be set to full, half, or auto, and not to full (auto). A full (auto) duplex setting
indicates that the port was set to auto-negotiate and it negotiated to full duplex.

The following tasks describe how you can access detailed hardware information for servers
and network devices directly in SA. See Network Device Information in NA on page 30 for
instructions on how to access hardware information about network devices directly in NA.
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Viewing Network Interfaces

To view hardware information about a server, including network interfaces, perform the

following steps:

1 Log in to the SA Client.

2
3
4
Explorer. See Figure 12.
Figure 12

From the View drop-down list, select Hardware.

Hardware View in the Server Explorer

From the Navigation pane, select Devices » All Managed Servers.

Double-click on a server in the Content pane to display hardware details in the Server
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Viewing Network Ports

SA-NA Integration

To view hardware information about a network device, including network ports, perform the

following steps:

1 Login to the SA Client.

2

a device group.
3

Explorer.
4

device. See Figure 13.

From the Navigation pane, select Devices » Device Groups » Public and then select

Double-click on a network device in the Content pane to display the Network Device

In the Views pane, select Hardware to display information about the selected network
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Figure 13 Hardware View in the Network Device Explorer
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Network Device Information in NA

To help you with troubleshooting tasks that involve network devices in your environment, you
can examine additional network device details and network device event history by logging
directly in to NA. The SA-NA Integration feature provides a login option to access detailed
information about network devices and their event history as recorded in NA.

Viewing a Network Device

To view detailed information about a network device:
1 From the Navigation pane, select Devices » Device Group » Public.

2 In the Content pane, select a network device.
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Figure 14 Network Device Details in NA
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change.

Figure 15 Event Details for a Network Device in NA
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Duplex Mismatch

The SA-NA Integration feature provides automatic detection of duplex mismatches. A duplex

mismatch is a configuration mismatch between the speed and duplex of a managed server and
a connected network device.

For servers’ network interfaces, speed and duplex information is gathered during every
hardware registration, which occurs every 24 hours.

Due to the lack of a device independent method of determining duplex for servers running a
Windows operating system, the Server Agent for Windows does not report duplex settings
out-of-the-box. A custom script can be added to the Server Agent to collect and report the
speed and duplex setting for a certain network interface. For instructions on how to create
and integrate the script with the Agent, contact your support representative.
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Speed and duplex information for servers is not updated when you select View » Refresh or
press F5 in the SA Client. This data gets updated when the NA Duplex Data Gathering
diagnostic runs. See NA Duplex Data Gathering Diagnostic on page 19.

For network devices, speed and duplex is gathered by the NA Duplex Data Gathering
diagnostic, which runs according to a schedule that you define. To ensure that you have the
latest speed and duplex information about network devices, it is recommended that you set up
a recurring schedule that runs the diagnostic. See the NA User Guide.

If the network interface information (speed and duplex) for a server does not match the
network port information (speed and duplex) for a connected network device, the device is
considered to be non-compliant.

In the SA-NA Integration feature, you can see duplex mismatches identified at a top level by
using the Dashboard. You can also see duplex mismatches identified by server and network
device by using the Server Explorer and Network Device Explorer, respectively.

Viewing Duplex Mismatches in the Dashboard

See the SA User Guide: Audit and Compliance for information about duplex compliance levels
and how they are displayed in the Dashboard.

Viewing Duplex Mismatches by Server

To view duplex mismatches using the Server Explorer, perform the following steps:
1 From the Navigation pane, select Devices » All Managed Servers.

In the Content pane, select a server.

Double-click on the server to display the Server Explorer.

In the Views pane, select Hardware.

g A W N

In the Network Interfaces section, review the Duplex column for detected mismatches.

Mismatches are identified by an R jcon that precedes the duplex setting (Full, Half,
Auto), in the Duplex column.

Viewing Duplex Mismatches by Network Device

To view duplex mismatches using the Network Device Explorer, perform the following steps:
1 From the Navigation pane, select Devices » Device Groups » Public.

In the Content pane, select a network device.

Double-click on the network device to display the Network Device Explorer.

In the Views pane, select Hardware.

g A W N

In the Network Ports section, review the Duplex column for detected mismatches.

Mismatches are identified by an & jcon that precedes the duplex setting (Full, Half,
Auto), in the Duplex column. See Figure 12.
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Network Reports

To help troubleshoot problems that involve physical connections and duplex compliance, you
can run and examine network reports. By using the Reports feature in the SA Client, you can
produce the following network reports that identify layer 1 connections between managed
servers and network devices in your environment:

Connections by Network Device

This report lists all physical connections to a selected network device.

Connections by Server

This report lists all physical connections to a selected managed server.

) See the SA Reports Guide for information about how to run, export, and print these reports.

Network Diagrams

You can use Service Automation Visualizer (SAV) functions in SA and the Diagramming
feature in NA to create detailed diagrams that illustrate managed servers, network devices,
and layer 2 and layer 1 connections in your environment. You can also export these network
diagrams to .gif, .9pg, and .svg files, annotate, and use them in other applications.

See the SA User Guide: Service Automation Visualizer (SAV) and the NA User Guide for more
information about SAV and the Diagramming tool.

Launching Service Automation Visualizer (SAV)

To access SAV, perform the following steps:
1 From the Navigation pane, select Devices » All Managed Servers.
2 In the Content pane, select one or more servers.

3 From the Tools menu, select Service Automation Visualizer (SAV) and then select
one of the following options:

e Select New to open the SAV window.
e Select Open to open a previously saved topology.

4 To create and export topology diagrams, see the procedures for using Service Automation
Visualizer (SAV) in the SA User Guide: Service Automation Visualizer (SAV) .

Launching NA Diagramming

See the NA User Guide for instructions on launching and using the NA Diagramming feature.
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NA and the SA Global Shell

You can use the SA Global File System (OGFS) to navigate between servers and connected
network devices by tracing their physical connections in the /opsw/Servers/@ and
/opsw/Network/@ directories in the OGFS.

You can also run three types of NA scripts in the OGF'S:
e Command

e Advanced

¢ Diagnostic

These scripts correspond to the three directories in the OGFS under
/opsw/Scripts/Network. See “Network Directories” in the SA User Guide: Server
Automation.

You can also write Bourne shell and Python scripts that can perform the following tasks when
run in the OGFS:

¢ Find servers and network devices.

e Find all servers that are connected to a specified switch.

¢ Find servers with a duplex mismatch.

e Display the network interfaces of a specified server.

¢ Get the IP addresses of all devices.

e Compare two files to identify changes in a network device's configuration.

e Change device details, such as the snmp-location.

Launching OGFS

To access the OGF'S in the Global Shell feature, perform the following steps:

1 From the Tools menu, select Global Shell to launch a terminal window. See “Opening a
Global Shell Session” in the SA User Guide: Server Automation for more details about
using OGFS.

2 To navigate between servers and connected network devices, use the guidelines described
in “SA Global Shell” and “OGFS Directories” in the SA User Guide: Server Automation.

Remote Terminal (rosh)

The rosh utility enables you to log in to devices (servers and network devices) and run native
commands. You invoke rosh from within a Global Shell session. You can run rosh and enter
native commands interactively, or you can specify the native commands as an option of rosh.

For example, you can log in to a switch with rosh and run the show vlan command to view
all VLAN details.

See “Remote Terminal” and “Logging on to a Managed Server With rosh” in the SA User
Guide: Server Automation for more information about using the rosh utility.
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Inferred Physical Connections

The SA-NA Integration feature also includes functionality that detects and reports on
inferred physical (layer 1) connections. These connections are inferred from data (such MAC
addresses that are seen by switches), captured, and then added to the SA data model.

These physical connections (inferred layer 1 data) are based on heuristics. In the OSI model,
each layer is an abstraction designed to hide the layer below. Therefore, the layer 2 data
gathered from devices cannot generate 100% accurate layer 1 data. In particular, layer 1 data
may be incorrect if any of the following conditions exist:

¢ The device does not return the port number where MAC addresses are seen.

e There was no traffic between the devices within a few minutes of when NA gathered the
topology data (where MAC addresses are seen).

e There is an unmanaged device between two managed devices.
e There is a hub between two managed devices.

In the SA Client, you can see inferred layer 1 connections by navigating network device
directories in Global Shell .

Device Groups and NA

A device group helps you categorize your devices (servers and network devices) in ways that
make sense for your organization. For example, you can group devices by customer, facility,
usage, application, and so on, and then perform actions on all of the devices in the group.

In SA, a device group can contain managed servers and network devices, or only managed
servers. In NA, a device group contains only network devices. You create and edit network
device groups only in NA. See the NA User Guide for more information about using the rosh
utility.

To monitor an application that is running on multiple servers and relies on multiple network
devices in your environment, HP recommends that you model it as a device group that
contains all servers and network devices the application runs on. This enables you to
troubleshoot the application by using SA.

Associating a NA Device Group

When you associate a public device group in SA with a device group in NA, you will be able to
monitor information about all servers and network devices that you are interested in. You
associate device groups by using identical group names.

Associated device groups have the following requirements:

e The SA device group is public.

e The SA device group is static.

e The names of the associated NA and SA device groups are identical.

To associate device groups in SA and NA, perform the following steps:

1  From the Navigation pane, select Devices » Device Groups » Public.

2 In the Content pane, select a device group.
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Right-click on the device group and then select Open to display the Device Group
Explorer.

From the View drop-down list, select Properties.

Check the “Associate with a NA device group of the same name” check box to enable this
functionality.

From the File menu, select Save.
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3 SA-OOQ Integration — Running Flows

This chapter describes how system integrators and flow managers can use Server Automation
(SA) to set up and run flows using SA. It also describes how users can run flows. Flows are
operations that perform some of the most common automated tasks.

SA-Operations Orchestration (OO) integration allows flow authors to build OO flows that are
integrated with SA and users to run flows from SA. See OO documentation for more
information about flows.

You must be familiar with SA, OO, and OO flows to implement the procedures described in
this chapter.

The chapter includes the following topics:

e  What’s New for SA-OO Integration on page 37
¢ Administrators: Setting Up Flows on page 38
e Users: Running Flows on page 45

To check for recent updates, to verify that you are using the most recent edition of a
document, or to check the release notes for the most up-to-date information, go to:

http:/h20230.www2.hp.com/selfsolve/manuals

What's New for SA-OOQ Integration

This section describes what is new in SA-OO integration for this version.

Support for OO 10.0

For the SA-OO Integration, SA 10.0 or later supports HP Operation Orchestration 10.0 and
9.0.

e 00 9.0 support is enabled by OO-SA 9.00.08 content
e 00 10.0 support enabled by OO-SA 10.00.01 content

NOTE: Version support and compatibility information is subject to change. For complete and
up-to-date support and compatibility information, see the support matrix for the relevant
product release. All support matrices and product manuals are available here on the HP
Software Support Online web site:

http:/support.openview.hp.com/sc/support_matrices.jsp

You can also download the HP Server Automation Support and Compatibility Matrix for this
release from the HP Software Support Online Product Manuals web site:

http:/support.openview.hp.com/selfsolve/manuals
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Edit Flow Integration Settings Window

This window, its sub-window, and its panels have two new functions: displaying real-time flow
information and replacing the OO Connector Configuration file functionality.

Displaying Real-Time Information
The Flow Integrations panel displays real-time information for an OO user whose credentials
are used to run flows from SA, to verify that SA and OO can communicate with one another,
and to verify that a user is a valid OO user. Any changes to user accounts (such as a disabled

account or changes to OO credentials (user name, password, or URL)) are displayed
instantaneously while this panel is open.

For more information on this panel, see Editing the Flow Integration Settings on page 40.

Administrators: Setting Up Flows

This section describes how system and flow administrators can set up OO flows in SA.

Prerequisites

This section describes the prerequisites that must be fulfilled to set up and run flows in the
SA Client.

Prerequisites for Using OO
This section describes the environment and the permissions required for using OO.

) NOTE: SA Integration can only be performed with one version of OO.

Environment

To use OO with SA to set up and run flows, your environment must meet the following requirements:
e SAversion 10.0
e HP Operations Orchestration (OO) version 7.5X, 7.6X, 9.X and 10.0

e (OO installation server networked to SA core server

e Valid OO SDK Client Certificate to communicate with OO

) NOTE: SA version 10.0 ships with OO SDK Client Certificate for OO 7.51.
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Importing the OO SDK Client Certificate

This section describes how to import the required OO SDK Client Certificate. You must
import the certificate before you can run OO flows from SA.

) NOTE: If your architecture includes a master core and one or more secondary cores, follow the
steps in this section for the master core and for each of the secondary cores. Similarly, if your
SA computer has a sliced-core installation with one or more slices, repeat the steps for each
slice.

To import the SDK:
1 Stop the Web Services Data Access Engine (Twist):

/etc/init.d/opsware-sas stop twist

2 Transfer the OO Central Certificate to SA:
(When you are prompted for a password for the next steps, use: changeit)
a Export the OO Central Certificate:

The procedure of exporting the OO client certificate depends on the OO version to
which you are connected:

0O Version Instructions

00 7.5x%, 7.6x, 9.0 Open a terminal on the SA core, and execute:

/opt/opsware/jdkl.6/jre/bin/keytool —-exportcert
-alias oocert2007 —-file /tmp/oocentral.crt
-keystore /var/opt/opsware/twist/oocert

00 9.0X (00 9.02.0002 | Open a terminal on the SA core, and execute:

r later
or later) /opt/opsware/jdkl.6/jre/bin/keytool -exportcert
-alias oocert2011 -file /tmp/oocentral.crt
-keystore /var/opt/opsware/twist/oocert
00 10.0 For this version of OO the procedure to export the

certificate may differ, depending on the OS version you
have on your OO server. For more details please consult
the OO documentation.

NOTE: The certificate export command must be run on
the OO server. As of SA 10.0, the client certificate is not
bundled with SA.

Example command for exporting the certificate from an OO 10.0 instance installed on
a Windows server:

<00 _INSTALL DIR>\java\win64\bin\keytool.exe -exportcert -alias tomcat
-file C:\oocentral.crt -keystore
<00 _INSTALL DIR>\centrall\var\security\key.store

Next, make sure you copy the C:\oocentral.crt file to the SA core, under /tmp/
oocentral.crt.

b  Import the OO Central Certificate to the SA Java Runtime Environment (JRE)
Keystore:
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/opt/opsware/jdkl.6/jre/bin/keytool -importcert -alias oocert -file /
tmp/oocentral.crt -keystore /opt/opsware/jdkl.6/jre/lib/security/
cacerts

) The example above uses the alias: ococert. However, any alias can be used when importing
the certificate, as long as it is not already used in that keystore.

¢ Make sure that no errors occurred when the commands were executed.
3 Check that the OO Central Certificate was imported successfully:

/opt/opsware/jdkl.6/jre/bin/keytool -list -—-alias pas —keystore /opt/
opsware/jdkl.6/jre/lib/security/cacerts

Example output:

pas, Feb 3, 2010, trustedCertEntry,
Certificate fingerprint (MD5):
DF:DD:22:1B:A2:1E:A9:9C:1C:AF:8F:E0:14:1F:B5:EQ

4  Start the Web Services Data Access Engine (Twist):

/etc/init.d/opsware-sas start twist

Permissions

In order to be able to use the SA-OO integration the users must be granted the following
permissions:

Table 2 Checking User Permissions

Permission Description Check in the SA Client

AdministerFlowIntegrations | Configure the OO integration | Select Administration in the
settings navigation panel. If the Flow
Integrations option appears
in the list of choices in the
navigation tree, the
permission has been granted.

RunFlowOption Run OO flows Select Devices in the
navigation panel. Select
Servers » All Managed
Servers. Right-click a server
name and choose Run. If the
Flow. .. option is visible, the
permission has been granted.

(for users who want to run
flows)

Editing the Flow Integration Settings

The Flow Integrations Settings in SA enable you to configure the integration between HP
Server Automation and HP Operations Orchestration.

To configure or edit the Flow Integration Settings:

1 In the SA Client navigation panel, select Administration » Flow Integrations.
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2 In the Flow Integrations panel, click Edit Settings to display the Edit Flow Integration
Settings window.

Figure 16 Edit Flow Integration Settings Window
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The Flow Integrations panel displays real-time information for the following users:
a For Job Blocking: OO user who has permission to run the Approval Flow.
b For Running Flows: OO user whose credentials are used to run flows from SA.

Any changes to user accounts (such as a disabled account or changes to OO

credentials (user name, password, or URL)) are displayed instantaneously while this
panel is open.

3  For running a flow, enter or change the following information:
— OO URL - the location of the OO server in the following format:
<protocol>://<hostname or host IP address>:<port number>/
Examples:

https://10.255.166.110:8443/
https://10.255.166.110:8443/PAS/

— OO user name and password ()

See Table 3 for more information.

For information about blocking jobs and the blocking job section of this window, see the
SA-OO - Blocking Jobs chapter.
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A hyphen designates an unconfigured status, a red check mark designates an invalid status,
and a green check mark designates a valid status. Both valid and invalid statuses are
displayed with their latest verification timestamp.

4 Click Verify Connection to check the validity of the credentials you entered.
If the connection status is valid, a check mark appears.

5 Click Apply to save the flow-integration settings changes.

The Apply button is disabled if no data exists in the Edit Flow Integration Settings panel, if
the data in the fields is incorrect, or if a check mark does not appear next to the connection
status.

Replacing OO Connector File Functionality

If you are upgrading from SA versions prior to SA 9.0 and you want to use flow inputs, you
must replace the inputs from the former OO Connector Configuration file into the
corresponding Edit Flow Integration Settings window fields. See Table 3 for mapping
information for the connection settings. See Editing the Flow Integration Settings on page 40
for more information on the interface.

Table 3 Mapping Configuration File Inputs to Integration Window Fields

0O Connector Edit Flow Integration
Configuration Inputs Description Settings Field
iconclude.enabled An integer, either: Connector Status from Job

1 - enable the connector | Blocking
0 - disable the connector

Default: 0

(in the Running Flows field)

iconclude.host OO server host name or IP OO URL

address Use the following syntax:

Default: None (required) <protocol>://<hostname

or host IP address>:<port

number>/
iconclude.port Port of the OO listener OO URL
Default: 8443 Use the following syntax:

<protocol>://<hostname
or host IP address>:<port
number>/

iconclude.protocol Protocol (http or https) for OO URL

connecting to the OO server Use the following syntax:

Default: htt
pS <protocol>://<hostname

or host IP address>:<port
number>/
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Table 3

Mapping Configuration File Inputs to Integration Window Fields

0O Connector Edit Flow Integration
Configuration Inputs Description Settings Field
iconclude. flow.approve | Path to the flow that will be Approval Flow

run (the flow is located in the

0O library)

Default: None (required)
iconclude.user OO user name 0O User Name

Default: None (required)
inconclude.password OO user’s clear text password | Password

Do not include this property in
a production environment

Default: None (required)

SA-OOQ Integration Flows

This section lists flow inputs. Flow authors can define the input name, input type, and
template in OO. After these inputs are defined and flows are run, SA automatically populates
their values into the OO-SA Library SACoreInputs table - you do not have to input these

values manually.

For these inputs:

e Ifthe input has a text, encrypted field, or free form list field, and OO provides a default
value, the field will be filled with the default value. If there is no default value, then, if you
followed the guidelines in Table 4, SA will fill the text field with one of the known inputs,

which you can modify.

e Ifthe input has a single-select list field or multi-select list field, OO provides the values -
you cannot modify these values.

For more information on defining flow inputs, see the OO documentation.

Table 4 Flow Inputs
Automatically Assigned Values (by
Flow Inputs Related to SA)
coreHost and SA Core Host and IP address of the SA core
coreIPAddress associated with the SA user who is logged
in to the SA Client
coreUsername or SA Core User name associated with the SA user
coreUser who is logged in to the SA Client
corePassword SA Core Password associated with the SA user who
is logged in to the SA Client
The contents of the field are encrypted.
coreVersion SA Core Current SA core version
SA provides these values

SA-OO Integration — Running Flows
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Table 4 Flow Inputs (cont’d)

Flow Inputs

Related to

Automatically Assigned Values (by
SA)

saServerIdentifier

SA Managed Server

Selected server identifiers:
You can set two possible values (in OO):
e Not Assigned (for one value)

e List of Values (for multiple values) -
Define the input as a freeFormList
type in OO.

saServerScriptName

SA Managed Server

Name of the server script that is available
in the SA core for that particular server’s
operating system

Automatically assigned values: None

Instead, the SA Client provides a widget
that enables users to select a server script
(excluding the OGF'S script).

saServerName/
hostName

SA Managed Server

DNS name of the selected server

This value is filled in only if one server is
selected.

You can set two possible values (in OO):
e Not Assigned (for one value)
e List of Values (for multiple values)

Define the input as a freeFormList type
in OO.

platformName

SA Managed Server

Operating system name of the selected
server

This value is filled in only if one server is
selected.

customerName

SA Managed Server

Customer name of the selected server
selected

This value is filled in only if one server is
selected.

facilityName

SA Managed Server

Name of the facility where the selected
server is located

This value is filled in only if one server is
selected.

sadobId

00

Job ID of the SA job that was used to run
the OO flow (tracked in OO using the
reports feature)

This input is not displayed.
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Veritying Your Changes and Settings
This section describes how to verify that your changes or settings have been applied.

Flow Edits and Flow Status

1 Log on to the SA Client.
2 In the navigation panel, select Administration.
3 In the navigation tree, select Flow Integrations.

Figure 17 Flow Integrations Panel
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The Flow Integrations panel displays real-time information for the following users:
a For Job Blocking: OO user who has permission to run the Approval Flow.
b For Running Flows: OO user whose credentials are used to run flows from SA.

Any changes to user accounts (such as a disabled account or changes to OO credentials (user
name, password, or URL)) are displayed instantaneously while this panel is open.

When the flow or job-blocking action is complete, a check mark appears next to the status.

Users: Running Flows

This section describes how users can run flows, choose servers, and choose flow inputs.

Users must have the Run Flow permission to run flows in SA.

Choosing a Flow to Run

To choose a flow to run:

1 In the SA Client navigation panel, select Devices.
2 In the top panel, select Servers » All Managed Servers.
You must select a server before you can select a flow.

3 Right-click a server name.
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Figure 18 Run Flow Option
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4  Select Run » Flow... to display the Select Flow OO window.

Figure 19 Select Flow Window
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5 In the Select Flow window, select a flow category from the library tree to display its
component flows.

6 In the name list, select a flow and click Select to display flow details in the Run Flow
window.
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Figure 20 Run Flow Window
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You can choose flow input, runtime option, scheduling option, and notification parameters.
See Choosing Flow Input, Runtime Option, Scheduling Option, and Notification Parameters
on page 47.

Adding or Deleting Servers

To add or delete servers:

1 First, follow the steps in Choosing a Flow to Run on page 45.

2 In the All Steps navigation panel of the Run Flow Window, select Devices.

3 Right-click a server icon and choose Add or Delete, or click the plus or minus sign.
The Select Servers and Device Groups window is displayed.

4 Click Select to add a server to the list of servers.

The Run Flow window displays the new server in the Devices panel, or shows that the
removed server is absent.

Choosing Flow Input, Runtime Option, Scheduling Option, and Notification Parameters
You can enter values for flow inputs, runtime options, scheduling, and notifications. Some
parameters will be automatically filled in already.

1 Follow the steps in Choosing a Flow to Run on page 45, then:

2 In the All Steps panel of the Run Flow Window, select each of the categories in turn
(Inputs, Options, Scheduling, and Notification) to enter values for their parameters, as the
rest of this procedure explains. Alternatively, you can choose Next from each panel to view
the categories.

3 To enter values for flow inputs, select Inputs in the All Steps panel and enter values for
the inputs that the panel displays. For example:

a saServerScriptName or click Select Script to display a list of scripts.
b saServerName

C saServerIdentifier
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See Table 4 for more information on inputs.

4 To enter values for runtime options, select Options from the All Steps panel, and enter a
value for the job timeout. This is the number of minutes that the server will run a job
before it times out. The default value is: 180 minutes and the timeout value is between 1
and 1440 minutes.

5 To select scheduling options, select Scheduling in the All Steps panel and enter values for:
a Schedule frequency
b Time and Duration

6 To enter notification information, click Notifications in the All Steps panel and add values
for:

a Recipient email address
b  Notifier (click Add Notifier)

¢ Ticket identification number (there are no conventions for the identification number -
you can choose any number)

7  Click Start Job to start the job, or click Cancel to erase the choices you made in this
session.

8 Click Job Status to view the status of the SA job. (optional)
Figure 21 SA Job Status
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The Job Status window does not display the flow run status, but rather the status of the SA
job that starts and monitors the flow in OO.

When the SA job is complete, this window displays the status of each step in the flow (in the
Response field) and a URL that points to more detailed flow-related information on OO.

It is possible that SA job monitoring succeeded even if at least one step failed. The OO API
does not provide a call that precisely determines success or failure of the entire OO flow.
Therefore, you cannot determine the success or failure of your OO flow from the SA Job Status
screen or from the information provided at the URL.
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Troubleshooting

SA-OQO Connection Error

If SA cannot connect to OO, administrators can:

e Check that the settings in the Edit Flow Integration Settings window fields are correct.
(See Editing the Flow Integration Settings on page 40.)

¢ Examine the following log file for error messages on the Command Engine server:
/var/log/opsware/waybot/waybot.err
The error messages do not appear in the SA Client.
¢ Check that the OO URL, user name, and password are correct.
e Make sure the specified OO user has correct permissions to run the flow.

To check a flow status, see the Flow Integration Panel. For more information on this panel, see
Editing the Flow Integration Settings on page 40.

If you are a user and you see this error, check with your administrator.

Flow Run Error

This section describes errors you might encounter when you run a flow as a user.
Incorrect Inputs

When you try to run a flow, you might receive one of the following error:

® SA will not pass the selected Device(s) to this flow

® SA-00 Integration Configuration Error: Flow Integration Settings are
incorrect. Please verify that the flow Integration URL, username, and
password are correct.

Typically, these errors are displayed when one or more of the following occurred:
*  You (as a user) selected the wrong flow to run.
e The OO server is not responding. Ask your administrator for help.

¢ The inputs an administrator entered in the Edit Flow Integration Settings window are
incorrect. Ask your administrator to check the information in the Edit Flow Integrations
Settings window. See Editing the Flow Integration Settings on page 40 for more
information.

e The flow author must modify the flow definition to use the naming conventions.
Inputs Not Defined or Server Only Accepts One Device
When you try to run a flow, you might receive the following error:

SA will not pass the selected Device(s) to this flow. Either the flow does not
have the required ServerIdentifier input defined or the input only accepts a
single device.

If you receive this error, ask your administrator to check the ServerIdentifier input.
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4 SA-OO Integration — Job Blocking and
Approving

Software Automation (SA) jobs are major processes, such as installing patches or checking
compliance, that you run in the SA Client.

This chapter describes how system integrators and software developers can block SA jobs in
SA, and approve or cancel jobs in SA using flows that call the SA API.

For more information on SA jobs, see the SA Application Deployment User Guide.

You must be familiar with SA, Operations Orchestration (0O0), SA jobs, and OO flows to block
and unblock jobs.

The chapter includes the following topics:
¢ Blocking Jobs on page 51
e Approving and Deleting Blocked Jobs on page 57

For more information about jobs, see the SA Application Deployment User Guide. For more
information on working with OO, see the OO documentation.

To check for recent updates, to verify that you are using the most recent edition of a
document, or to check the release notes for the most up-to-date information, go to:

http:/h20230.www2.hp.com/selfsolve/manuals

Blocking Jobs

This section describes several scenarios for blocking jobs, the types of jobs that can be blocked,
the permissions needed to block jobs, how to block a job, how to disable job blocking, and how
to view information related to a blocked job.

What are Blocked Jobs?

Some SA jobs might need to be reviewed and approved before they are executed. This section
contains three sample scenarios of jobs that are candidates for job blocking.

Scenario 1

A job’s approval should be postponed until the job can be run in the early morning hours if
running it requires a system reboot. If the job were to run during regular business hours, it
would disrupt normal work processes.

Scenario 2

Some jobs require further review before they can be run. For example, if a job updates a
particular software application on a server, a Change Advisory Board (CAB) might need to
review the proposed upgrade to make sure it does not conflict with other applications running
in the environment. The board would determine if the job should run and when.
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Scenario 3

In many IT environments, certain operations must be assigned tickets, assessed, and
approved before they can be executed or cancelled. These jobs need to be blocked so the ticket
can be created in the ticketing system, evaluated, and resolved.

What SA Job Types Can be Blocked?

The following table describes the SA job types.

52

Table 5 Blockable SA Job Types

Job Type

Function

Clone Virtual Machine

Clones a virtual machine on a VMware server

Create Snapshot

Creates a snapshot that captures the configuration of a
managed server at a particular point in time

Create Virtual Machine Provisions a virtual machine and installs an operating

(Hyper-V) system on a Hyper-V virtual machine

Create Virtual Machine Provisions a virtual machine and installs an operating

(VMWare) system on a VMware ESX server

Create Virtual Zone Provisions a Solaris virtual machine (non-global zone) on a
global zone (Hypervisor)

Delete Virtual Machine Deletes a virtual machine

Install Patch Installs any patch on a managed server

Install Software

Installs any software on a managed server

Modify Virtual Machine Modifies the properties of a VMware virtual machine
Modify Virtual Machine Modifies the properties of a Hyper-V virtual machine
(Hyper-V)

Modify Virtual Zone Modifies the properties of a Solaris virtual machine
Push Configurations Modifies configuration files on a managed server

Reboot Servers

Reboots servers

Remediate Audit Results

Remediates servers based on the findings of an audit
operation

Remediate Policies

Remediates servers based on a software policy or a patch
policy

Remediate Snapshot Results

Remediates servers based on a snapshot. A snapshot
captures the configuration of a managed server at a
particular point in time

Remove Virtual Machine

Removes a virtual machine from a VMware ESX server
(Hypervisor)

Remove Virtual Zone

Removes a Solaris virtual machine (non-global zone) from a
global zone (Hypervisor)
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Table 5

Blockable SA Job Types (cont’d)

Job Type

Function

Restore Configurations

Restores a previous version of configuration files on a server

Every time you push configurations to a server, the previous
configuration are saved and can be restored.

Run Audit

Runs audits

Run Custom Extension

Runs custom extensions

Run ISM Control

Runs an ISM (Intelligent Software Module) control

An ISM is an installable software package created with the
ISM Development Kit (IDK). An ISM can contain control
scripts that perform day-to-day, application-specific tasks,
such as starting software servers.

Run OGFS Script Runs an OGF'S (Global File System) script on a server
The OGFS scripts allows you to execute scripts in the Global
Shell from the SA Client.

Run OS Build Plan Runs OS builds plans

Run OS Sequence

Provisions a server and installs an operating system using
an OS sequence

An OS sequence defines what to install on an unprovisioned
server, including OS build information from the OS
installation profile, software and patch policies, and
remediation settings.

Run Program Extension

Runs a custom feature added to SA

HP can extend the functionality of SA by creating custom
extensions to provide for specific customer needs.

Run Server Script

Runs a script on a server

Uninstall Patch

Uninstalls a patch on a server

Uninstall Software

Uninstalls software on a server

SRequired Permissions

The following permissions are required:

— Edit or Cancel Any Job (allows you to edit or cancel jobs if you launch a flow)

— View All Jobs (allows you to view jobs if you launch a flow)

— Manage Job Blocking (allows you to block and unblock jobs)

— Administer Flow Integration (allows you to configure the SA-OO integration
connection settings to OO and specify the Approval Flow)

SA-OO Integration — Job Blocking and Approving
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How Do | Block and Unblock Jobs?

This section describes how to designate job types to block and how to disable job blocking.

How Do | Designate Job Types to Block?

To designate the type of jobs to block:
1 In the SA Client, select Administration in the navigation pane.

2 Select Job Blocking in the navigation tree. The list of job types is displayed in the right
pane with a check box next to each type.

Figure 22 Blocking SA Job Types
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See Table 5 to see which types of jobs are available.
3 Select the check box: Enable Blocking Jobs.
This action sets up the potential to block all job types listed in the panel.

4 In the panel below the Enable Blocking Jobs check box, select the check box next to each
job type you want to block. Jobs that correspond to the blocked job type will be unable to
run until they receive the appropriate approval.

This action designates individual job types to block.
5 Click Apply Changes to block jobs belonging to the job types you selected.

Note: When you block jobs of a particular type, you block all future jobs that belong to that
type until you deselect the Required Approval box for that job.
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How Do | Disable Job Blocking?

To disable job blocking:
1 In the SA Client, select Administration in the navigation pane.
2 Select Job Blocking in the navigation pane.

3 Deselect the check box corresponding to the job that you no longer want to block.
This action disables job blocking for individual job types.

4 Above the list of job types, deselect the Enable Blocking Jobs check box. (See Figure 22.)
This action disables job blocking for all job types.
5 Click Apply Changes.

) When you deselect the Enable Blocking Jobs check box, the checks next to the job types
designated for blocking remain checked for your convenience.

How Do | View Blocked-Job Information?

You can view OO connection information in the Flow Integrations panel and check job-status
information in the job log.

Checking OO Connection Information in the SA Flow Integrations Panel

Choose Administration » Flow Integrations to access the Flow Integrations Panel.

Figure 23 Flow Integrations Panel
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The Flow Integrations panel displays real-time information for the following users:
a For Job Blocking: OO user who has permission to run the Approval Flow
b  For Running Flows: OO user whose credentials are used to run flows from SA

Any changes to user accounts (such as a disabled account or changes to OO credentials
(user name, password, or URL)) are displayed instantaneously while this panel is open.

A check mark appears next to the status if the connection to OO is active.
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Checking Blocked-Job Status in the Job Log
If you know a job has been blocked and you want to see whether the job block has been lifted,
check the job log (choose Jobs and Sessions »Job Logs » Any Status).

For a list of possible job status values and what they mean, see Table 7.

Configuring or Editing a Flow Setting

To edit or configure a flow setting, you must be logged in to OO and SA.
In the SA Client navigation panel:

1 Select Administration » Flow Integrations.

2 In the Flow Integrations panel, click Edit Settings to display the Edit Flow Integration
Settings window.

Figure 24 Edit Flow Integration Settings Window
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00 login credentials, dick the Verify Connection button to test the connection,

and then select the flow for approving blocked jobs. To allow users to run 0O flows,
enter the OO login credential for running flows. Click the Verify Connection button
to test the connection and review the flows that can be run.

OO URL:

~Job Blocking
OO0 User Name:

Password: ssssnssns

Approval Flow: JLibrary fSaufapprove Blocked Jobed Job Select Flow

Verify Connection

Connection Status: -

Running Flows

00 User Name:
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Connection Status: -

Verify Connection

Apply

The Flow Integrations panel displays real-time information for the following users:

a For Job Blocking: OO user who has permission to run the Approval Flow.

b  For Running Flows: OO user whose credentials are used to run flows from SA.
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Any changes to user accounts (such as a disabled account or changes to OO credentials
(user name, password, or URL)) are displayed instantaneously while this panel is open.

3 For running a flow, enter or change the following information:
— OO URL - the location of the OO server in the following format:
<protocol>://<hostname or host IP address>:<port number>/
Examples:

https://10.255.166.110:8443/
https://10.255.166.110:8443/PAS/

— Approval Flow - the location of the approval flow
— OO user name and password of the user who is authorized to communicate with OO

See Table 3 for more information.
) A hyphen designates an unconfigured status, a red check mark designates an invalid status,

and a green check mark designates a valid status. Both valid and invalid statuses are
displayed with their latest verification timestamp.

4 Click Verify Connection to check the validity of the credentials you entered.
If the connection status is valid, a check mark appears.
5 Click Apply to save the flow-integration settings changes.
) The Apply button is disabled if no data exists in the Edit Flow Integration Settings panel, if

the data in the fields is incorrect, or if a check mark does not appear next to the connection
status.

Approving and Deleting Blocked Jobs

You can use the SA Application Programming Interface (SA API) to approve or delete jobs.
This API is the only way to manage blocked jobs. You cannot approve a blocked job through
the SA Client. For information about using the SA API, see the SA Platform Developer Guide.

For information on blocking jobs using OO, see the OO documentation.

Java Methods for Handling Blocked Jobs

The JobService Java interface in the SA API provides Java methods for handling blocked
jobs. These methods are the callbacks into SA that enable job approval integration.

) Users who invoke these methods must have the following required permissions:
Edit or Cancel Any Job and View All Jobs
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The following table describes the SA JobService Java methods that you can use to handle

blocked jobs.
Table 6 SA JobService Java Methods
Java Method Method Description SA CLI Method Examples
JobService. Authorizes the job and unblocks it, | Within a Global Shell session:
approveBlockedJob allowing it to execute. cd /opsw/api/com/opsware/job/
JobService/method. /approveBlockedJob
self:i=$job id
JobService. Changes the value of the Ticket cd /opsw/api/com/opsware/job/
updateBlockedJob 1D field (corresponding to the JobService/
userTag parameter) and Reason method. /updateBlockedJob
field (corresponding to the self:i=$job id
blockReason parameter) of the userTag=5$ticket id \blockReason=
blocked job in the Job Status "This type of job requires approval
window of the SA Client. of CMB."
Note: You cannot change these
fields using the SA interface.
JobService. Cancels a blocked job and prevents | (Note that the ID parameter is jobRef, not
cancelScheduledJob it from executing. self)
Changes the status of the blocked | cd /opsw/api/com/opsware/job/
job from Awaiting Approval to JobService/method. /
Cancelled. cancelScheduledJob jobRef:i=$job id
\reason="Job was scheduled to run
outside of change window."
A job that is currently running (job_status
= "ACTIVE") cannot be canceled.
JobService. Searches all existing jobs and (Specify the job status string in the filter,
findJobRefs returns the IDs of all blocked jobs | not the JobInfoVO.status integer.)

or jobs in other states, such as jobs
in progress, expired jobs, and
scheduled jobs.

Can view jobs launched by other
users.

cd /opsw/api/com/opsware/job/
JobService/method./.findJobRefs: i
filter="job:{job status = "BLOCKED"
}I

The job_id attribute is required when a flow must come back to SA and interact with the job.
Job blocking requires this attribute to be sent from SA to OO.

Job-Status Values

This section describes the job-status values, which you can use in the job_status searchable
attribute, as well as the corresponding integer values for the JobInfovO. status, which you
can examine if your client code has already retrieved the value object (VO).

Table 7 lists allowed job-status values.
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In a Java client, you can compare JobInfoVO.status with field constants such as
STATUS ACTIVE, instead of using the integers listed in this table.

Table 7 Job-Status Values

Value of the

job_status

Searchable | Value of Job Status Displayed

Attribute JobInfoVO.status | in the SA Client Job Status Description

ABORTED 0 Command Engine Script |dJob has finished running.

Failure A Command Engine failure has been

detected.

ACTIVE 1 In Progress Job is currently running.

BLOCKED 11 Pending Approval Job has been launched, but requires
approval before it can run.

CANCELLED 2 N/A Schedule has been deleted.

DELETED 3 Canceled Job was scheduled but was later canceled.

EXPIRED 13 Expired Current date is later than the job schedule's
end date, so the job schedule is no longer in
effect.

FATLURE 4 Completed with Errors | Job has finished running and an error has
been detected.

PENDING 5 SCHEDULED Job is scheduled to run once in the future.

RECURRING 12 RECURRING Job is scheduled to run repeatedly in the
future.

STALE 10 STALE

SUCCESS 6 COMPLETED Job has finished running successfully.

TAMPERED 9 TAMPERED

UNKNOWN 7 Unknown

WARNING 8 Completed With Job has finished running and a warning has

Warnings been detected.
ZOMBIE 14 Orphaned

SA-OO Integration — Job Blocking and Approving

59



60

Chapter 4



5 SA-uCMDB Connector

The SA-uCMDB Integration

This describes how to integrate HP Server Automation (SA) with the HP Universal
Configuration Management Database (uUCMDB) using the SA-uCMDB Connector. The
SA-uCMDB Connector provides a single source for configuration data for asset compliance
reporting.

HP SA stores a large amount of information about your servers and software in the SA
database. The SA-uCMDB Connector copies some of this data to the HP uCMDB. Whenever
the data in SA changes, the SA-uCMDB Connector automatically sends the updated data to
the uCMDB Server.

The HP Universal CMDB is a configuration management database (CMDB) for enterprise IT
organizations to document, store, and manage business service definitions and associated
infrastructure relationships. The uCMDB provides a shared single version of truth to support
business service management, I'T service management, change management, and asset
management initiatives. These initiatives help align IT efforts with business requirements
and run IT operations more efficiently and effectively.

HP Server Automation provides life cycle management for enterprise servers and applications
from discovery to provisioning, patching to configuration management and script execution to
compliance assurance. HP Server Automation automates operations and processes across
disparate IT teams and systems.

Highlighted Features

e Extended Out-Of-The-Box mappings

¢ Extensible ETL mapping and data normalizing capabilities

¢ Global uCMDB IDs

¢ On-demand Sync

e SSL Connectivity to the uCMDB Server and the uCMDB Browser
e  Support for SA Custom Attributes

e Support for uCMDB server versions 9.05 and 10.01

uCMDB Browser

With the SA-uCMDB Connector, the SA Client provides the ability to launch the uCMDB
Browser-Impact widget against an SA managed server.

For more information, see Support for uCMDB Browser integration in the SA Client.
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Installing and Contiguring the SA-uCMDB Connector

The SA-uCMDB Connector is installed when you install SA. No separate installation is
required.

If you are upgrading to Server Automation 10.0, the uCMDB Server must already be
upgraded to release 9.05, 10.01 or later.

) The version compatibility information herein is correct at the time this document is released.

However, cross-product version support can change over the lifecycle of a product version. For

up-to-date support and compatibility information, see the HP Server Automation Support and
Compatibility Matrix for the relevant product release.

To download the latest Cumulative Update Package:

1 The SA 10.0 SA-uCMDB Connector requires that you run with uCMDB 9.05 or uUCMDB
10.01 or later.

— uCMDB 9.05 must include Cumulative Update Package 6 (CUP 6) or higher.
— uCMDB 10.01 includes Content Pack 12.
— Both are minimal requirements for using the SA-uCMDB Connector.

The latest CUP HP Software Patch is available on the SSO Portal at the following
locations:

— Windows:

http://support.openview.hp.com/selfsolve/document/FID/
DOCUMENTUM_uCMDB_00094

— Linux:

http://support.openview.hp.com/selfsolve/document/FID/
DOCUMENTUM_uCMDB_00095

For version support information, see Support for uCMDB Server Versions 9.05 and 10.01.
This site requires that you register for an HP Passport and sign in.

2 Run the enable command to configure the SA-uCMDB Connector with the new uCMDB
server.

) The syntax of the enable command varies depending on your environment. See The enable
Command in this document for an explanation of the enable command syntax and options.

3  Enter the following command to start the SA-uCMDB Connector:
/etc/init.d/opsware-sas start telldaemon
4 Optionally check the status of the SA-uCMDB Connector with the following command:

/etc/init.d/opsware-sas status telldaemon
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http://support.openview.hp.com/selfsolve/document/FID/DOCUMENTUM_uCMDB_00095
http://support.openview.hp.com/selfsolve/document/FID/DOCUMENTUM_uCMDB_00094

Customizing SA Data Sent to the u~CMDB Server

The Mapping File

The SA-uCMDB Connector XML mapping file describes the data being transferred by the
SA-uCMDB Connector and enables you to customize the data mappings.

The initial mapping.xml is generated when the connector first runs. After it is generated, you
can find the new mapping file at:

/etc/opt/opsware/tell/metadata/mapping.xml
The mapping file allows you to control:
e the data type and attributes that populate uCMDB and

¢ the mappings between the optional SA custom attributes and the uCMDB Data Model
Configuration Item (CI) attributes.

) See EXAMPLE — SA-uCMDB Connector Mapping File for the complete original mapping file
contents.

Customizing the Mapping File

In order to customize how data is mapped, you need to create and modify the
mapping_custom.xml file, and then restart the Connector.

) The mapping_custom.xml file is not used by default, so you need to restart the Connector to
engage the customized mapping file.

To customize the u~CMDB Connector mappings:

1 If the uCMDB Connector is running, you must stop and disable the Connector before
editing the mapping file.

) See Stopping and Disabling the SA-uCMDB Connector for instructions.

IMPORTANT: Make sure the connector is stopped and disabled. If the connector is not
stopped and disabled when you edit the mapping file, you may encounter problems when you
try to restart the Connector.

2 Create the custom mapping file:
a Go to: /etc/opt/opsware/tell/metadata

b Copy the mapping.xml file to the same folder and name the copy
mapping custom.xml.

) The mapping_custom.xml file must be in the same specified folder as the mapping.xml file
to function properly.

3 Edit the /etc/opt/opsware/tell/metadata/mapping_custom.xml as needed.
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See Editing the Mapping File for details on how to edit the mapping file for different
purposes.

4  Run the enable command to change the configurations of the SA-uCMDB Connector.

The syntax of the enable command varies depending on your environment. See The enable
Command in this document for an explanation of the enable command syntax and options.

5 Run the start command to restart the SA-uCMDB Connector:
/etc/init.d/opsware-sas start telldaemon
6  Optionally check the status of the SA-uCMDB Connector with the following command:

/etc/init.d/opsware-sas status telldaemon

Editing the Mapping File

All customized mappings are defined in the mapping_custom.xml configuration file, so
administrators can easily view and edit them. The XML mapping file can be modified to
change the data being transferred by the SA-uCMDB connector. The mapping file also
provides the ability to choose to omit specific CI and attributes. If the mapping_custom.xml
does not exist, the connector by default will honor the out of box mapping.xml.

Permissions: In order to view or edit the mapping_custom.xml file, you must first log in to
the SA Core as root in order to have read/write privileges.

This section describes your editing options within the customized mapping file. For
instructions on the process for customizing the mapping file, including when you need to stop
and start the connecter in order to make the changes take effect, see Customizing the
Mapping File.

lllustration of Mapping File

Here is a snippet of the out-of-the-box mapping file:

<Model-Definition model-name='hosts'>
<CI ucmdb-ci-type-name='node' enable='true' base-class="'node'
<Attribute source='Node/Name' target-attr='name' enable='true'/>
<Attribute source='Node/Description' target-attr='description'
enable='true'/>
</CI>
</Model-Definition>

where the highlighted text indicates editable fields.

See EXAMPLE — SA-uCMDB Connector Mapping File for complete out-of-the-box mapping
file.

Each Model Definition tag in the mapping file defines a specific model name. In this example,
this Model-Definition defines the ‘hosts’ model.

Each model can contain many Configuration Items (CIs). Each CI tag defines the composition
of the CI. In this example, ‘node’ is the CI being defined.
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For each attribute, source indicates the default attribute name in the source database.

¢ The target-attr field specifies the uCMDB attribute name that the source is mapping to.

¢ The enable field defines whether to map the attribute. The default value for enable is
‘true’; which means the attribute will be loaded into the uCMDB. When you set enable to
‘false’, you are choosing not to map the attribute; which means the attribute will not be
loaded to uCMDB.

XML Attribute Values

Table 8 shows the XML attribute values, indicating the editable and non-editable values:

0 WARNING: Do not change non-editable attribute values. It is crucial that the non-editable
values, such as, source='Node/Name', remain unchanged. Changing these values can prevent
the synchronization from running properly and can lead to errors.

Table 8 XML Attribute Values
XML
Attribute
Tag Attributes Sample Attribute Values and Notes Editable?
Model- model-name | ‘hosts’, ‘sa’, 'software', NOT
Definition 'compliance', 'hypervisor', editable
'vmrelations', 'compliance status'
enable ‘true’ to enable this attribute; ‘false’ to Editable
disable
CI ucmdb-ci- Specifies the uUCMDB CI type. For example: Editable
type-name ‘node’, ‘ip address’
enable ‘true’ to enable this attribute; ‘false’ to Editable
disable

SA-uCMDB Connector

65



66

Table 8 XML Attribute Values (cont’d)

XML
Attribute
Tag

Attributes

Sample Attribute Values and Notes

Editable?

Attribute

source

Specifies the SA custom attribute name. For
example:

'"Node/Name', 'Node/Description', 'Node/
BiosAssetTag', 'Node/BiosSerialNumber',
'Node/Facility', 'Node/
VirtualizationTypeId'

WARNING: Do not edit the Source value.
Modifying the Source value will damage the
mapping and may cause errors.

NOT
editable

target-attr

Specifies the uUCMDB attribute name that the
source is mapping to. For example:

‘name’, ‘description’

NOTE: target-attr value must be a unique
name.

Editable

enable

‘true’ to enable this attribute; ‘false’ to
disable.

Editable

conversion-
name

Only used for conversion functions. See
Customized Data Conversion Function for
details. For example:

"com.hp.tell.ConversionMethod$com.hp.te
11. MyConvertVirtualizationType'

Editable

Attribute-
Custom

sa-custom-
attribute-
key-value

Specifies the SA custom attribute name. For
example:

‘HW RACK’, 'DEVICE RACK'
NOTE: See Support for SA Custom Attributes.

Editable

target-attr

Specifies the uCMDB attribute name that the
source is mapping to. For example:

‘serial number’, ‘facility’

NOTE: target-attr value must be a unique
name.

Editable

enable

‘true’ to enable this attribute; ‘false’ to
disable.

Editable

CI-Filter

enable

‘true’ to enable this attribute; ‘false’ to
disable.

NOTE: See Filter Support for Queries for
modifying CDATA block.

Editable
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Table 8 XML Attribute Values (cont’d)

XML
Attribute
Tag Attributes Sample Attribute Values and Notes Editable?
Relation ucmdb- Specifies uCMDB relationship between the CIs. | Editable
relation- For example: 'containment', ' regation'
type-name ple: 'containment', 'aggregatio
ucmdb- Specifies uUCMDB relationship between the Cls | Editable
relation- of the “from’ CL
irl(::l:l-type For example, if specifying a containment
relationship from node to ip_address, the
‘node’ would be the *from’ CI in this
relationship.
ucmdb- Specifies uUCMDB relationship between the CIs | Editable
relation- of the ‘to’ CI.
::;—;:;type- For example, if specifying a containment
relationship from node to ip_address, the
‘ip-address’ would be the ‘to’ CI in this
relationship.
enable ‘true’ to enable this attribute; ‘false’ to Editable
disable.
ucmdb- ‘true’ if the relationship contains an ID link. | Editable
relation-id- | This ‘true’ value requires the ‘from’ CI to
link exist, ‘false’ if the relationship does not
contain an ID link

Model Definitions

Table 9 shows model definitions. There are 7 models defined in the mapping file that define
how data objects are represented in uCMDB. For example, the SA model would represent SA

in uCMDB.

Table 9 Model Definitions

Model Definition model-name Description

‘sa’ generates installed_software.xml
‘hosts’ generates node.xml

‘software’ generates installed_software.xml
‘compliance’ generates policy-xml

‘hypervisor’ generates hypervisor.xml
‘vmrelations’ generates hypervisor.Relationxml

b

‘compliance_status

generates policyResult.xml
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) These XML files are generated internally based on the mapping file and should not be edited
directly. Editing the generated XML files directly is not supported. Any changes made to the
generated files will be overwritten.

Support for SA Custom Attributes

) IMPORTANT: All editing of mapping files must be done in the mapping_custom.xml file. Do
not edit the out-of-the-box mapping.xml file. Editing the mapping.xml file directly can prevent
the synchronization from running properly and can lead to errors.

How to Transfer SA Custom Attributes to u~CMDB

Custom attributes can also be loaded to uCMDB.

In addition to the SA attributes that are synchronized with uCMDB, the mappings in the
mapping_custom.xml file enable you to specify any SA Custom Attributes defined with an
SA Device or inherited from SA Facilities.

Custom Attributes can be specified in the mapping_custom.xml file as follows:

The following example shows how a user could configure the mapping file to extract the
custom attribute, DEVICE_RACK, and load it to the my_location_rack destination in uCMDB.
The enable attribute is set to ‘true, showing that the user chose to load this attribute to
uCMDB.

<CI ucmdb-ci-type-name='node' enable='true' base-class='node'>
<Attribute-Custom sa-custom-attribute-key-value='DEVICE RACK' target-
attr='my location rack' enable='true' />

</CI>

where the highlighted text indicates editable fields.

Filter Support for Queries

The mapping_custom.xml file provides the capability to filter specific criteria.

To filter by specific criteria:

e Embed the filtering clause in the CDATA section under CI-Filter tag.

e Specify whether the filter is enabled by supplying the value for enable attribute (‘true’ to
enable, ‘false’ to disable).

) The CI-Filter specification is based on the SA database and requires knowledge of the SA
schema. You can only supply one CI-Filter per CI type. If multiple filters are needed, you can
specify a simple filter expression using AND and OR clauses.

Example of a single filter (out-of-the-box mapping in mapping.xml file):

<CI ucmdb-ci-type-name='node' enable='true' base-class='node'>
<Attribute source='Node/Name' target-attr='name' enable='true' />
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<CI-Filter enable='true'><![CDATA[(DEVICES.OPSW_LIFECYCLE =
'MANAGED') ] ]1></CI-Filter>
</CI>

In the above example, the filter selects SA devices with State: ‘managed’. By default, the
SA-uCMDB Connector only synchronizes Managed device objects.

Example of a filter which includes an AND clause (modified mapping in
mapping_custom.xml):

<CI-Filter enable='true'><![CDATA[ (DEVICES.DVC MODEL = 'POWEREDGE 2950') and
(DEVICES.DVC ID > 300000000)]]1></CI-Filter>

In the above example, the filter selects SA devices with BOTH the Model, POWEREDGE
2950, and the ID greater than ‘300000000’

Extended Out-Of-The-Box Mappings

The mapping file is provided to enable you to:

e Change names of attributes being populated in uCMDB
e Change how data is populated in uCMDB

e Specify which uCMDB CI type gets populated

Additional Out-of-the-Box Mappings

The Facility and VirtualizationType attributes are disabled by default in the
out-of-the-box mapping file. However, they may be enabled, as shown below:

ServerVO.getFacility()

<Attribute source='Node/Facility' target-attr='facility' enable='true'/>

ServerVO.getVirtualizationType()

<Attribute source='Node/VirtualizationTypeId'
target-attr='virtualization type id' enable='true'/>

Customized Data Conversion Function

If data to be populated in uCMDB needs to be tailored during synchronization, custom
conversion methods can be written and provided to the SA-uCMDB Connector. The
SA-uCMDB Connector can, then, apply these functions to transform the data from the SA
syntax to the desired uUCMDB syntax. For example, you can write custom conversion methods
to convert lower case to upper case, or bytes to megabytes, and so on.

Customized conversion functions should be provided to the SA-uCMDB Connector via a jar
file named tell_conversions.jar, and placed in /etc/opt/opsware/tell/lib prior to the
connector startup. After you restart the connector, the custom conversion java class should
extend the ConversionMethod class and import the com.hp.tell.ConversionMethod
package.

To customize data conversion:

1 Ifthe SA-uCMDB Connector is running, you must stop and disable the Connector before
editing the mapping file.
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¢ Run the stop command to stop the SA-uCMDB Connector:
/etc/init.d/opsware-sas stop telldaemon

¢ Run the disable command to disable the SA-uCMDB Connector:
disable

IMPORTANT: Make sure the connector is stopped and disabled. If the connector is not
stopped and disabled when you edit the mapping file, you may encounter problems when you
try to restart the Connector.

2  Write the customized conversation function code in java.

For example, see Sample Conversion File — MyConvertVirtualizationType.Java. In this
example, the conversion file’s name is MyConvertVirtualizationType.java.

3 Modify the mapping_custom.xml file to utilize the conversion file that you just created.

For example, you would place the following line in the mapping_custom.xml file to point to
the java file, MyConvertVirtualizationType.java:

Original text in mapping file

<Attribute source='Node/VirtualizationTypeId'
target-attr='virtualization type id' enable='false'/>

Customized text in mapping file

<Attribute source='Node/VirtualizationTypelId' target-attr='device isVirtual'
enable="'true'

conversion-name='com.hp. tell.ConversionMethodScom. hp. tell.MyConvertVirtualiza
tionType'/>

This modified line of XML has the following values:

® ‘'device isVirtual’ is the new attribute value for target-attr. Because this conversion
changes the data type, it should be mapped to a different uCMDB attribute. However, if
you are not changing the data type, then you should map to the same target-attr value.*

e conversion-name is the XML name for the conversion attribute. This is a verbatim label
and cannot be substituted.

® ‘com.hp.tell.ConversionMethodScom.hp.tell.MyConvertVirtualizationType' is
the attribute value for conversion-name, and MyConvertVirtualizationType.java is the
java conversion code file name.

The target-attr value is critical fo the success of the conversion operation:

Changing data types

If the conversion is changing an attribute’s data type, make sure that the destination
attribute (specified by target-attr) has the same or compatible requirements, such as length
and format. In the previous example, we modified the target-attr value because the
conversion changes the actual data type. If, for example, you were merely converting the unit
of measure (UOM), then you could specify the same target-attr value, because the actual
data type did not change.

Unique filename per target-attr
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Each target-attr conversion requires a unique java conversion code filename. The java
conversion file represents a singular target-attr (output). For example, you can have
multiple target-attr conversion scenarios for a single source attribute; however, each
target-attr must be stated on an individual attribute tag in the mapping file, as shown in the
following example:

<Attribute source='Node/VirtualizationTypeId'
target-attr='virtualization type idl'

enable="'true'

conversion-name='com.hp. tell.ConversionMethodScom. hp. tell.MyConvertVirtualiza
tionTypel' />

<Attribute source='Node/VirtualizationTypeId'
target-attr='virtualization type id2'

enable="'true'

conversion-name='com.hp. tell.ConversionMethodScom. hp. tell.MyConvertVirtualiza
tionType2'/>

4  Compile the customized conversion file (MyConvertVirtualizationType.java in this
example). This generates the executable binaries.

5 Compress all of the conversion binaries into a jar file with the following name:
tell_conversions.jar.

) You must use this exact jar filename for the SA-uCMDB Connector to recognize it.

6 Place the jar file in the SA Core directory, /etc/opt/opsware/tell/lib, prior to the starting
up the uCMDB Connector.

) You must use this exact directory path for the SA-uCMDB Connector to recognize it.

7 Start the SA-uCMDB Connector.

The conversion function will convert the data dynamically, at the time the SA-uCMDB
Connector is restarted.

Sample Conversion File — MyConvertVirtualizationType.Java

This sample conversion file provides sample java code to use as a guideline. This java sample
converts an SA VirtualizationType from Type: Numeric into Type: String for uCMDB.

) You can only have one attribute conversion per java file. To convert multiple attributes, you
need to have multiple java files. Each target attribute can only have one conversion.

Tip: Name the conversion file based on the attribute being modified. As in this example, the
java filename is MyConvertVirtualizationType because it is modifying the
VirtualizationType attribute.

package com.hp.tell;

import java.math.BigDecimal;
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import com.hp.tell.ConversionMethod;
public class MyConvertVirtualizationType extends ConversionMethod {
public Object convert (Object value) throws Exception({

Integer vType = putlnteger (value);
String vValue;

/*
* Function to convert SA VirtualizationType (numeric) to string type For
uCMDB.
*/

if (vType > 0) {
vValue = "True";
} else {
vValue = "False";

return vValue;

private Integer putInteger (Object o) throws Exception {
if (o instanceof String) {
return Integer.valueOf ((String) o);

}

if (o instanceof BigDecimal) {
return ((BigDecimal)o) .intValue();

}

if (o instanceof Integer) {
return (Integer)o;

}

throw new Exception ("Invalid conversion in putInteger
"+o.getClass () .toString());
}
}

Managing the SA-uCMDB Connector

Stopping and Disabling the SA-uCMDB Connector

If the SA-uCMDB Connector is running, you must stop and disable the Connector before
making any kind of configuration change.

To stop and disable the SA-uCMDB Connector:
1 Run the stop command to stop the SA-uCMDB Connector:
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/etc/init.d/opsware-sas stop telldaemon
2 Run the disable command to disable the SA-uCMDB Connector:
disable

IMPORTANT: Make sure the connector is stopped and disabled before making any
configuration change. If the connector is not stopped and disabled, you may encounter
problems when you try to restart the Connector.

The stop Command

When you stop the SA-uCMDB Connector, it will stop transferring data from the SA database
to uCMDB. To stop the SA-uCMDB Connector, enter the following command on an SA core
server:

/etc/init.d/opsware-sas stop telldaemon
This stops the SA-uCMDB Connector.
If the SA-uCMDB Connector is disabled, the output will look like the following:

opsware-sas: One or more of the specified components does not exist
in the following file:
/opt/opsware/oi util/startup/components.config

If you no longer need the SA-uCMDB Connector, you can disable it with the disable command.
For more information, see The disable Command.

The disable Command

Use the disable command to disable the SA-uCMDB Connector. If the SA-uCMDB Connector
is running, the disable command will stop it before disabling it. If the SA-uCMDB Connector
is disabled, you will not be able to start it.

The disable command modifies the file /opt/opsware/oi_util/startup/components.config
and comments out the lines for the telldaemon, which is the process for the SA-uCMDB
Connector.

Location of the disable Command

The disable command is located on your SA core server in the directory /opt/opsware/tell/
bin.

Syntax of the disable Command

disable

Enabling and Starting the SA-uCMDB Connector

Before starting the SA-uCMDB Connector, you must enable it to make sure the most up to
date configuration elements are engaged.

To enable and start the SA-uCMDB Connector:

1 Run the enable command to change the configurations of the SA-uCMDB Connector.
There are multiple options for the enable command depending on your configuration.
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The following is a simple example of this command:

enable --host myserverOl.hp.com --port 8888 --user ucmdb-admin
——password 1eM93A3dme

For more information about the complete set of parameters, syntax, and options, see The
enable Command.

2 Run the start command to restart the SA-uCMDB Connector:
/etc/init.d/opsware-sas start telldaemon

3 Optionally check the status of the SA-uCMDB Connector with the following command:
/etc/init.d/opsware-sas status telldaemon

For more information, see Displaying the Status of the SA-uCMDB Connector.

The enable Command

Before you can start the SA-uCMDB Connector, you must enable it with the enable
command. When you enable it, you provide the uCMDB server name or IP address, port
number, login, and password.

Use the enable command to configure and enable the SA-uCMDB Connector. This section
describes the enable command. You must enable the SA-uCMDB Connector before you can
start it.

The enable command does the following:

e C(Creates a custom SA-uCMDB Connector configuration file, /etc/opt/opsware/tell/
tell_custom.conf, if it does not already exist. (By default, the custom configuration file
does not pre-exist upon deployment unless one has been created manually.)

e Modifies the custom configuration file, /etc/opt/opsware/tell/tell_custom.conf, and
enters the uCMDB server’s host name or IP address, port number, and login into this file.

e Saves the user’s password.

e  Modifies the file /opt/opsware/oi_util/startup/components.config and uncomments
the lines for the telldaemon, which is the process for the SA-uCMDB Connector.

If you modify any of the uCMDB configuration parameters while the SA-uCMDB Connector is
running, you must stop and restart the SA-uCMDB Connector for your changes to take effect.

Location of the enable Command

The enable command is located on your SA core server in the directory /opt/opsware/tell/
bin.

New Syntax in the enable Command

In SA 9.14, additional parameters were added to the SA-uCMDB Connector’s enable
command in order to support the new uCMDB Browser. The new parameters are described in
this section and in Table 10.

enable [--protocol <ucmdb protocol>] [--host <ucmdb host ip>] [--port
<ucmdb_host port number>] [--browser protocol <ucmdb browser protocol>]
[--browser host <ucmdb browser host ip>] [--browser port

<ucmdb browser host port>] [--user <ucmdb admin user>] [--password
<ucmdb admin password>] [--help]
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Table 10 New Parameters for the enable Command

Parameter Description New
—--protocol uCMDB server protocol, http or https. Default is New
<ucmdb_protocol> http.
--host <ucmdb_host ip> This option gives the IP address or host name of your | —
HP uCMDB server. The default value is localhost.
—--port This option gives the port number of your HP —
<ucmdb _host port number> | uCMDB server. The default value is 8080.
—-browser protocol uCMDB Browser server protocol, http or https. New
<ucmdb browser protocol> | Default is http.
--browser host This option gives the IP address or host name of your | New
<ucmdb browser host ip> | HP uCMDB Browser host name or IP. The default
value is localhost.
--browser port This option gives uCMDB Browser host port. The New

<ucmdb browser host
port>

default value is 8080.

--user
<ucmdb admin user>

This option gives the user name of an administrative
user for your HP uCMDB server. The default value is
admin.

—-—-password
<ucmdb_admin password>

This option gives the password for the user provided
in the --user option. The default value is admin.

Example of enable command without SSL enabled:

enable —-protocol http --host 192.168.8.93 —--port 9999 —-browser protocol
http —-browser host 192.168.8.100 —--browser port 8888 --user john-ucmdb

-—password mypassl234

Example of enable command with SSL enabled for the uMCDB Server and the uCMDB

Browser:

enable —-protocol https --host 192.168.8.93 --port 9999 —-browser protocol
https —-browser host 192.168.8.100 —-browser port 8888 --user john-ucmdb

-—-password mypassl234

Displaying the Status of the SA-uCMDB Connector

To display the status of the SA-uCMDB Connector, enter the following command on an SA

core server:

/etc/init.d/opsware-sas status telldaemon

If the SA-uCMDB Connector is enabled but not running, the output will look like the

following:

Verify "telldaemon" running: FAILURE

(pidfile does not exist)

Failed to perform "status" operation on Opsware SAS components.
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If the SA-uCMDB Connector is disabled, the output will look like the following:

opsware-sas: One or more of the specified components does not exist in the

following file:
/opt/opsware/oi util/startup/components.config

SA-uCMDB Data Relationship and Transfer

Cl Relationships Maintained

Table 11 lists the Configuration Item (CI) relationships maintained by the SA-uCMDB
Connector.

Table 11 CI Relationships Maintained

From uCMDB CI Via From uCMDB CI
Node containment IpAddress

Node composition InstalledSoftware
Node composition Hypervisor

Node aggregation PolicyResult
Hypervisor ExecutionEnvironment Node

Policy composition PolicyResult
SaSystem aggregation Node

SaSystem aggregation Policy

Example: uCMDB Showing an SA Managed Server

Figure 25 is from an HP uCMDB screen and it shows:

76

One SA managed server named “atari.”
The managed server’s IP address 10.12.10.65.

The managed server “atari” is running a VMware hypervisor.

Two virtual machines are running on the hypervisor named “gofish” and “miracles.”
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Figure 25 SA Managed Servers Displayed in the uCMDB
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SA Data Transferred to u~CMDB

The following data from the SA database is transferred to the uCMDB Configuration Items
(CI) and Attributes (see Table 12):

Table 12 uCMDB CIs and Attributes Populated by SA

uCMDB CI uCMDB Attribute
Node Name

Node Description

Node BiosAssetTag

Node DefaultGatewaylpAddress
Node NodeModel

Node SerialNumber
Node BiosUuid

Node NetBiosName

Node MemorySize

Node OsDescription
Node OsFamily

Node TenantOwner
IpAddress Name

IpAddress RoutingDomain
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Table 12 uCMDB CIs and Attributes Populated by SA (cont’d)

uCMDB CI uCMDB Attribute
InstalledSoftware Name
InstalledSoftware Vendor
InstalledSoftware BuildNumber
InstalledSoftware DmlProductName
Hypervisor Name

Hypervisor Description
Hypervisor ProductName
Policy Name

Policy Description

Policy PolicyCategory
Policy PolicyDefinedBy
PolicyResult Name

PolicyResult PolicyResultDateTime
PolicyResult ComplianceStatus
PolicyResult RulesCompliant
PolicyResult RulesNonCompliant
PolicyResult ComplianceLevel
SASystem Name

SASystem Description
SASystem Version

Frequency of Data Transfer to uCMDB

When the SA-uCMDB Connector first starts running, it queries the SA database, creates the
CIs in the uCMDB and transfers the data from SA to the uCMDB. After that, whenever the
data in the SA database changes, the SA-uCMDB Connector automatically detects the
changes and transfers the modified data to the uCMDB. The connector logs information in the
log file /var/log/opsware/tell/LOAD_STATS.0.log.

For the complete list of data transferred from SA to the uCMDB, see SA Data Transferred to

uCMDB.
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Accessing the uCMDB Browser from the SA Client

The uCMDB Browser Window

You can view server details in the uCMDB Browser window.

To view server details:

1 Login to the SA Client.
2 Go to Devices > All Managed Servers.
3 Select any server and click Actions > Open with uCMDB Browser.

Optional: You can also use the context menu here or on the search panel. Select the server,
then right-click and choose Open With > uCMDB browser.

Sample URL that SA uses to open the uUCMDB Browser for a specific Managed Server:

http://my-ucmdb.mycomp.com: 8080 /ucmdb—api/ucmdb-browser/
?locale=en&theme=LIGHT#refocus-selection=<global ucmdb id>

4 Ifyou are not already logged in to the uCMDB Browser, this will invoke the uUCMDB
Browser Login screen. Complete using your uCMDB login credentials. You will only need
to sign in once per session.

Tip: If a blank page or a Page Not Found error occurs when you open the uCMDB Browser, it
could mean that either uCMDB is not set up or the uCMDB server is not running or
configured correctly. Make sure that the uCMDB server is configured and that the
Tellconnector is running.

If the SA-uCMDB Connector has not been configured and you need to disable the ‘Open with
uCMDB Browser’ menu item, go to System Configuration > Opsware > Tell and set the
values to no value for uCMDB Browser URL and uCMDB URL.

Configuring the u~CMDB Browser

If the uCMDB Browser needs to be invoked from the SA Client, the uCMDB Browser’s related
parameters need to be specified after enabling the SA-uCMDB Connector using the following
lopt/opsware/tell/bin/enable parameters:

--browser protocol - uCMDB Browser server protocol, http or https
--browser host - uCMDB Browser host name or IP
-—browser port - uCMDB Browser host port
Also, by default the SA Client invokes the uCMDB Browser via the uCMDB 9.05-compatible
URL prefix.

For example, to use the uCMDB 10.01-based Browser:

1 Stop the SA-uCMDB Connector by running the stop command:
/etc/init.d/opsware-sas stop telldaemon

2 Disable the SA-uCMDB Connector by running the disable command:
disable
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IMPORTANT: Make sure the connector is stopped and disabled. If the connector is not
stopped and disabled when you revise the configuration file, you may encounter problems
when you try to restart the Connector.

3 Update the uCMDB Browser prefix in the custom SA-uCMDB Connector configuration
file /etc/opt/opsware/tell/tell_custom.conf to indicate the correct uCMDB version.

For example:

Change from the following uCMDB 9.05 default:
com.hp.sa.tell.ucmdb.browser.path.suffix=/ucmdb-api/ucmdb-browser
To the uCMDB 10.01 prefix:
com.hp.sa.tell.ucmdb.browser.path.suffix=/ucmdb-browser

4 After the configuration file is updated, enable the SA-uCMDB Connector by running the
enable command.

) The syntax of the enable command varies depending on your environment. See The enable
Command in this document for an explanation of the enable command syntax and options.

5 Restart the uCMDB Connector. Enter the following command to start the SA-uCMDB
Connector:

/etc/init.d/opsware-sas start telldaemon
6 Optionally check the status of the SA-uCMDB Connector with the following command:

/etc/init.d/opsware-sas status telldaemon

Support for ~CMDB Server Versions 9.05 and 10.01

For the SA-uCMDB Integration, SA 9.14 or later supports the following uUCMDB Server
integrations:

e uCMDB 9.05 Content Pack 10 or higher, Cumulative Update Package 6 or higher
e uCMDB 10.01 Content Pack 12

) Version support and compatibility information is subject to change. For complete and
up-to-date support and compatibility information, see the support matrix for the relevant
product release. All support matrices and product manuals are available here on the HP
Software Support Online web site:

http://support.openview.hp.com/sc/support_matrices.jsp

You can also download the HP Server Automation Support and Compatibility Matrix for this
release from the HP Software Support Online Product Manuals web site:

http://support.openview.hp.com/selfsolve/manuals

Global uCMDB IDs

With uCMDB 9.04 and earlier, only the local uCMDB IDs as known to that uCMDB server
were synchronized in SA.
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With uCMDB 9.05 and later, the uCMDB Servers can be configured as uCMDB Global ID
generators, where the uCMDB IDs generated are global and unique in multi-uCMDB server
environments. In such environments, these global IDs are needed to invoke the uCMDB
Browser properly.

The SA 9.14 SA-uCMDB Connector was enhanced to automatically use the global uCMDB ID
of Cls if the uCMDB Server is configured as a global ID generator. No special configuration is
needed for the SA-uCMDB Connector.

SSL Connectivity to the uCMDB Server and the uCMDB Browser

The SA-uCMDB Connector supports SSL protocol for the uCMDB Server and the uCMDB
Browser.

When enabling Secure Sockets Layer Communication (SSL), the appropriate certificate and
keystore need to be in place for the SA-uCMDB Connector.

To enable SSL:

1 Follow the instructions in the uCMDB Deployment Guide, “Enabling Secure Sockets
Layer Communication,” to create a uCMDB keystore and export the certificate to a file.

2 Import exported certificate from step 1 to where the SA-uCMDB Connector is installed.
For example, the keystore must be placed in /var/opt/opsware/crypto/tell with the
keystore filename: tell.keystore and the keystore password: hppass.

Example of import command:

/opt/opsware/jdkl.6/bin/keytool -import -noprompt -alias hpsaucmdb -file
<path to the exported hpcert> -keypass hppass -keystore /var/opt/opsware/
crypto/tell/tell.keystore —-storepass hppass

Configurable Files Archived During Upgrade

During upgrade, certain customizable and configurable files will be archived for preservation.

If you are upgrading from the SA-uCMDB Connector 9.14 to 10.0 following files will be
archived in /var/opt/opsware/install opsware/config file archive/<respective
path for file>

® tell.conf

® mapping.xml

® logging.properties

® tell conversions.jar
® tell.pwd

® tell.keystore

For example, the tell_custom.conf residing in /etc/opt/opsware/tell/tell_custom.com
will be archived to /var/opt/opsware/install opsware/config file archive/etc/
opt/opsware/tell/tell custom.com<time stamp of upgrade>

For the SA-uCMDB Connector 10.0 and future upgrades, tell_custom.conf and
mapping_custom.xml will also be archived for preservation.
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Troubleshooting Tips

Running the SA-uCMDB Connector on a Second Core

In some cases, a particular core in a multi-master SA Mesh needs to be deactivated and it
becomes necessary to run the SA-uCMDB Connector from a different core in that mesh.
Sometimes this is also needed if network performance from another core to the uCMDB server
is preferred. In those scenarios, the following steps are necessary:

To run the connector on a second core:

1

Stop the SA-uCMDB Connector on the first core and remove its affinity to it.

/etc/init.d/opsware-sas stop telldaemon
/opt/opsware/tell/bin/tell --release

On the second core, enable the SA-uCMDB Connector by running the enable command.

) The syntax of the enable command varies depending on your environment. See The enable
Command in this document for an explanation of the enable command syntax and options.

Take responsibility of the SA-uCMDB integration, and then start the SA-uCMDB
Connector.

/opt/opsware/tell/bin/tell —--take
/etc/init.d/opsware-sas start telldaemon

To enable additional logging:

1

Start the SA-uCMDB Connector.

Normal log files are stored in the /var/log/opsware/tell directory. Default file names
include the following:

tell.0.log (normal startup log)
ucmdb failure.*.log (uCMDB failures seen during synchronization)
LOAD STATS.*.log (number of processed data)

To request additional logging details, specify the requested information in the /etc/opt/
opsware/tell/logging.properties file as shown in Table 13.

Table 13 /etc/opt/opsware/tell/logging.properties Fields

Field Description

java.util.logging.FileHandler.limit Specifies the maximum number of bytes to

write to any one file. Default value is
10000000.

java.util.logging.FileHandler.count Specifies the number of files to use. Default

value is 10.

java.util.logging.FileHandler.append | Specifies append mode, defaults to true.

java.util.logging.FileHandler.pattern | Specifies the pattern for naming the output

file where the log file can be found. Defaults
to /var/log/opsware/tell/tell.%g.log
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0 CAUTION: Use caution when modifying the file limit. Large numbers might impact
performance.

On-Demand Synchronization

Upon SA restart, the SA-uCMDB Connector normally continues synchronizing SA data to
uCMDB from where it ended before the restart. The connector also runs a full sync,
periodically. However, in some cases, such as when there are networking or server issues that
prevent the updates from reaching the uCMDB server, you may need to trigger the full sync
on demand.

To trigger the synchronization on demand:
1 Stop the SA-uCMDB Connector.

2 Restart the SA-uCMDB Connector with the following option:

/opt/opsware/tell/bin/tell --startfresh

Viewing Log Files
The SA-uCMDB Connector generates the following text log files. You can view these log files
in a text editor to get more information.

e /var/log/opsware/tell/tell.0.log is the main log file for information, warnings and errors
encountered by the SA-uCMDB Connector.

e /var/log/opsware/tell/LOAD_STATS.0.log contains the status and statistics of the
initial data load, and approximate times to complete the initial data load.

e /var/log/opsware/tell/lucmdb_failure.0.log contains uCMDB errors, primarily
reconciliation errors if the SA data is incomplete, for example, if the required uCMDB
keys are missing. This could happen if a server did not have a serial number or an IP
address, for example. This log file contains the uCMDB exception, the reason why it failed
and a trace of the Cls that caused the exception.

SA-uCMDB Connector Daemon

The SA-uCMDB Connector runs the daemon /etc/opt/opsware/startup/telldaemon on your
SA core server. Make sure this process is running on your SA core server.

If it is not running, start it as described in Enabling and Starting the SA-uCMDB Connector.

If it is running, check the status as described in Displaying the Status of the SA-uCMDB
Connector.

EXAMPLE - SA-uCMDB Connector Mapping File

<DB-UCMBD-HIGHLEVEL-MAPPING>
<!-- generates installed software.xml -->
<Model-Definition model-name='sa' enable='true'>
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<CI ucmdb-ci-type-name='server automation system' enable='true'
base-class='server automation system'>
<Attribute source='SA/Description' target-attr='description'
enable='true'/>
<Attribute source='SA/Name' target-attr='name' enable='true'/>
<Attribute-Default target-attr='version' target-attr-value='9.14'
enable='true'/>
</CI>
</Model-Definition>

<!-- generates node.xml -->
<Model-Definition model-name='hosts' enable='true'>
<CI ucmdb-ci-type-name='server automation system' reference-ci='true'
enable='true'/>

<CI ucmdb-ci-type-name='ip address' enable='true' base-class='node'>
<Attribute source='IpAddress/PrimaryIpName' target-attr='name'
enable='true'/>
<Attribute source='IpAddress/RoutingDomain'
target-attr='routing domain' enable='true'/>
</CI>

<CI ucmdb-ci-type-name='node' enable='true' base-class='node'>

<Attribute source='Node/Name' target-attr='name' enable='true'/>

<Attribute source='Node/Description' target-attr='description'
enable='true'/>

<Attribute source='Node/BiosAssetTag' target-attr='bios asset tag'

enable='true'/>

<Attribute source='Node/BiosSerialNumber'
target-attr='serial number' enable='true'/>

<Attribute source='Node/BiosUuid' target-attr='bios uuid'
enable='true'/>

<Attribute source='Node/DefaultGatewayIlpAddress'
target-attr='default gateway ip address' enable='true'/>

<Attribute source='Node/NetBiosName' target-attr='net bios name'
enable='true'/>

<Attribute source='Node/NodeModel' target-attr='node model'
enable='true'/>

<Attribute source='Node/MemorySize' target-attr='memory size'
enable='true'/>

<Attribute source='Node/OsDescription'
target-attr='os description' enable='true'/>

<Attribute source='Node/OsFamily' target-attr='os family'
enable='true'/>

<Attribute source='Node/TenantOwner' target-attr='TenantOwner'
enable='true'/>

<Attribute source='Node/Facility' target-attr='facility'
enable='false'/>

<Attribute source='Node/VirtualizationTypeId'
target-attr='virtualization type id' enable='false'/>

<Attribute source='IpAddress/ManagementIpName'
target-attr='ip address' enable='false'/>

<CI-Filter enable='true'><![CDATA[ (DEVICES.OPSW LIFECYCLE =
'MANAGED') ] 1></CI-Filter>
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</CI>

<Relation ucmdb-relation-type-name='containment'
ucmdb-relation-from-ci-type-name="node'
ucmdb-relation-to-ci-type-name='ip address' enable='true'
ucmdb-relation-id-link="true'/>

<Relation ucmdb-relation-type-name='aggregation'
ucmdb-relation-from-ci-type-name='server automation system'
ucmdb-relation-to-ci-type-name='node' enable='true'
ucmdb-relation-id-link="'false'/>

</Model-Definition>

<!-- generates installed software.xml -->
<Model-Definition model-name='software' enable='true'>
<CI ucmdb-ci-type-name='node' base-class='node' reference-ci='true'
enable="true'/>

<CI ucmdb-ci-type-name='installed software' enable='true'
base-class='installed software'>
<Attribute source='InstalledSoftware/DmlProductName'
target-attr='dml product name' enable='true'/>
<Attribute source='InstalledSoftware/Name' target-attr='name'
enable="true'/>
<Attribute source='InstalledSoftware/Version'
target-attr='version' enable='true'/>
<Attribute source='InstalledSoftware/Vendor' target-attr='vendor'
enable="true'/>
</CI>

<Relation ucmdb-relation-type-name='composition'
ucmdb-relation-from-ci-type-name="node'
ucmdb-relation-to-ci-type-name='installed software'
ucmdb-relation-id-link="true' enable='true'/>
</Model-Definition>

<!-- generates policy.xml -->
<Model-Definition model-name='compliance' enable='true'>
<CI ucmdb-ci-type-name='server automation system' reference-ci='true'
enable='true'/>

<CI ucmdb-ci-type-name='policy' base-class='policy' enable='true'>
<Attribute source='Policy/Name' target-attr='name' enable='true'/>
<Attribute source='Policy/Description' target-attr='description'
enable='true'/>
<Attribute-Default target-attr='policy defined by’
target-attr-value='SA' enable='true'/>
<Attribute-Default target-attr='policy category'
target-attr-value='audit' enable='true'/>
</CI>
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<Relation ucmdb-relation-type-name='aggregation'
ucmdb-relation-from-ci-type-name='server automation system'
ucmdb-relation-to-ci-type-name="policy' enable='true'
ucmdb-relation-id-link="'false'/>
</Model-Definition>

<!-- generates hypervisor.xml -->
<Model-Definition model-name='hypervisor' enable='true'>
<CI ucmdb-ci-type-name='node' base-class='node' reference-ci='true'
enable='true'/>

<CI ucmdb-ci-type-name="'hypervisor' base-class='hypervisor'
enable="true'>
<Attribute source='Hypervisor/Name' target-attr='name'
enable='true'/>
<Attribute source='Hypervisor/Description'
target-attr='description' enable='true'/>
<Attribute source='Hypervisor/ProductName'
target-attr='product name' enable='true'/>
</CI>

<Relation ucmdb-relation-type-name='composition'
ucmdb-relation-from-ci-type-name="node'
ucmdb-relation-to-ci-type-name="hypervisor' ucmdb-relation-id-link="'true'
enable='true'/>
</Model-Definition>

<!-- generates hypervisorRelation.xml -->
<Model-Definition model-name='vmrelations' enable='true'>
<CI ucmdb-ci-type-name="'hypervisor' base-class='hypervisor'
reference-ci="'true' enable='true'/>

<CI ucmdb-ci-type-name='node' base-class='node' reference-ci='true'
enable='true'/>

<Relation ucmdb-relation-type-name='execution environment'
ucmdb-relation-from-ci-type-name="'hypervisor'
ucmdb-relation-to-ci-type-name="'node' ucmdb-relation-id-link="'false'
enable='true'/>
</Model-Definition>

<!-- generates policyResult.xml -->
<Model-Definition model-name='compliance status' enable='true'>
<CI ucmdb-ci-type-name='policy' base-class='policy'
reference-ci="true' enable='true'/>

<CI ucmdb-ci-type-name='node' base-class='node' reference-ci='true'
enable='true'/>

<CI ucmdb-ci-type-name='policy result' base-class='policy result'
enable="true'>
<Attribute source='PolicyResult/Name' target-attr='name'
enable='true'/>
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<Attribute source='PolicyResult/ComplianceStatus'
target-attr='compliance status' enable='true'/>

<Attribute source='PolicyResult/PolicyResultDateTime'
target-attr='policy result date time' enable='true'/>

<Attribute source='PolicyResult/RulesCompliant'
target-attr='rules compliant' enable='true'/>

<Attribute source='PolicyResult/RulesNonCompliant'
target-attr='rules non compliant' enable='true'/>

<Attribute source='PolicyResult/Compliancelevel'
target-attr='compliance level' enable='true'/>

</CI>

<Relation ucmdb-relation-type-name='composition'
ucmdb-relation-from-ci-type-name="'policy'
ucmdb-relation-to-ci-type-name='policy result' ucmdb-relation-id-link="'false'
enable='true'/>

<Relation ucmdb-relation-type-name='aggregation'
ucmdb-relation-from-ci-type-name="node'
ucmdb-relation-to-ci-type-name='policy result' ucmdb-relation-id-link='true'
enable='true'/>

</Model-Definition>

</DB-UCMBD-HIGHLEVEL-MAPPING>
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